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IDEAL INDUSTRIES STANDARD WARRANTY POLICY 
 

IDEAL INDUSTRIES warrants that all LANTEK Products manufactured or procured by 
IDEAL INDUSTRIES conform to IDEAL INDUSTRIES’ published specifications and are 
free from defects in materials and workmanship for a period of two (2) years from the 
date of delivery to the original Buyer, when used under normal operating conditions 
and within the service conditions for which they are designed. This warranty is not 
transferable and does not apply to used or demonstration products. 

The obligation of IDEAL INDUSTRIES arising from a Warranty claim shall be limited to 
repairing, or at its option, replacing without charge, any assembly or component 
(except batteries and cable adapters), which in IDEAL INDUSTRIES’ sole opinion 
proves to be defective within the scope of the Warranty. In the event Ideal Industries 
is not able to modify, repair or replace nonconforming defective parts or components 
to a condition as warranted within a reasonable time after receipt thereof, Buyers shall 
receive credit in the amount of the original invoiced price of the product. 

IDEAL INDUSTRIES must be notified in writing of the defect or nonconformity within 
the Warranty period and the affected Product returned to IDEAL INDUSTRIES’ factory, 
designated Service Provider, or Authorized Service Center within thirty (30) days after 
discovery of such defect or nonconformity. Buyer shall prepay shipping charges and 
insurance for Products returned to IDEAL INDUSTRIES or its designated Service 
Provider for warranty service. IDEAL INDUSTRIES or its designated Service Provider 
shall pay costs for return of Products to Buyer. 

IDEAL INDUSTRIES shall have no responsibility for any defect or damage caused by 
improper storage, improper installation, unauthorized modification, misuse, neglect, 
inadequate maintenance, accident or for any Product which has been repaired or 
altered by anyone other than IDEAL INDUSTRIES or its authorized representative or 
not in accordance with instructions furnished by IDEAL INDUSTRIES. 

The Warranty described above is Buyer’s sole and exclusive remedy and no other 
warranty, whether written or oral, expressed or implied by statute or course of dealing 
shall apply. IDEAL INDUSTRIES specifically disclaims the implied warranties of 
merchantability and fitness for a particular purpose. No statement, representation, 
agreement, or understanding, oral or written, made by an agent, distributor, or 
employee of IDEAL INDUSTRIES, which is not contained in the foregoing Warranty will 
be binding upon IDEAL INDUSTRIES, unless made in writing and executed by an 
authorized representative of IDEAL INDUSTRIES. Under no circumstances shall IDEAL 
INDUSTRIES be liable for any direct, indirect, special, incidental, or consequential 
damages, expenses, or losses, including loss of profits, based on contract, tort, or any 
other legal theory. 

 

IDEAL INDUSTRIES recommends that the user review all of the information in 
Appendix A, SAFETY PRECAUTIONS, prior to using the LANTEK tester. 
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OPERATIONAL NOTES, CAUTIONS, AND WARNINGS 

The following symbols are used in this manual to indicate that the user should use 
particular caution in order to prevent personal injury or damage to the tester or the 
system under test. 

 Exercise caution when you see this symbol. It indicates actions that could be 
harmful to the user or to the equipment. 

 Exercise extreme caution when you see this symbol. It indicates potentially 
lethal voltages. 

 

TYPOGRAPHICAL CONVENTIONS 
 

Boldface Refers to the name of a button on the keypad or screen. For example, 
the Enter key will be referred to as Enter. 

Italics Refers to a section, heading, or title within this manual. 

Quotation marks Identifies a “Screen Message”. 
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CHAPTER 1 
YOUR CABLE TESTER 

 

PRODUCT FEATURES 

Table 1-1: LANTEK Product Features 

FEATURES 
LANTEK 6 

Basic 
LANTEK 6A 
Premium 

LANTEK 7G 
Premium 

Frequency Range 350 MHz 500 MHz 1 GHz 

 Supports CAT 7 & ISO F Upgradeable Upgradeable 

Supports CAT 6a Upgradeable   

Supports CAT 6/5e/3 and ISO –E/D/C    

Accuracy Level III/IIIe (Draft)/IV 
(LANTEK 6/6A/7G) 

ETL ETL ETL 

Support DUALmode Testing to save time    

Test with Patchcords to save money    

CAT 6 Test Storage with graphs 500 500 500 

Expansion Slots 2 PCMCIA 2 PCMCIA 2 PCMCIA 

Standard External Compact Flash Memory Option 64 MB 64 MB 

USB/Serial Port    

Copper TDR Trace    

Fiber Loss Measurement (FIBERTEK) Option Option Option 

Fiber Distance to Event (TRACETEK) Option Option Option 

Talk over Fiber & Copper (Full Duplex)    

Display Screen on Remote    

Troubleshooting Tone Generator on Near 
End and Remote 

   

External Rapid Battery Charger & Extra 
Batteries 

Option   
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PRODUCT AND PERFORMANCE SPECIFICATIONS 

The LANTEK family of LAN cable certification testers is designed to test and measure 
twisted pair, coaxial and fiber-optic cable used for high-speed data communications 
networks.  The following tables describes the LANTEK product specification as well as 
the LANTEK, FIBERTEK, and TRACETEK performance specifications 

PRODUCT SPECIFICATIONS 

Standard Test Compliance 

ANSI/TIA/EIA 568B, CAT 6A(Draft)/6/5e/3, ISO-F/E/D/C, AS/NZS 3080, IEEE 802.3 
Ethernet, EN50173 – F/E/D/C 

Cable Types 

UTP/ScTP/FTP CAT 3/5e/6/7; IBM STP Type 1, 2, 6 Coax, 110/66/210 Block 

Dimensions (Display and Remote) 

10.1” x 5.0” x 2.3” 

256mm x 127mm x58mm 

Weight 

Display 2.3 lb (1050g)  

Remote 2.0 lb (914g) 

Battery 1.2 lb (548g) 

Battery Packs 

NiMH (Rechargeable) 

Typical Operating Life (Battery) 

8 hours 

Maximum Operating Temperature 

0oC to 50oC 

Maximum Storage Temperature 

-20oC to +70oC 

Humidity 

5 to 90% noncondensing 
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PERFORMANCE SPECIFICATIONS 
 

Table 1-2: LANTEK Performance Specification 

LANTEKTM Range Resolution Accuracy 

Length (50-100μ cable) 0-2000 ft 1 ft/0.1 m + (3% + 3 ft) 

Delay 0-8000 ns 1 ns/0.1 m + (3% + 1 ns) 

Average Impedance 35-180 Ω 0.1 Ω + (3% + 1 Ω) 

Capacitance (Bulk) 0-100 nF 1 pF or 3 dig + (2% + 20 pF) 

Capacitance 0-100 pF/ft 0.1 pF + (2% + 1 pF) 

DC Loop Resistance 35-200 Ω 0.1 Ω + (1% + 2 Ω) 

Attenuation 1 MHz – 1 GHz 0.1 dB Level III/IIIe(Draft)/IV 

NEXT 1 MHz – 1 GHz 0.1 dB Level III/IIIe(Draft)/IV 

Return Loss 1 MHz – 1 GHz 0.1 dB Level III/IIIe(Draft)/IV 

ELFEXT 1 MHz – 1 GHz 0.1 dB Level III/IIIe(Draft)/IV 

 
 

Table 1-3: FIBERTEK Performance Specification 

Specifications FIBERTEKTM

Detector 
Receive Wavelength: 

 
MM: 850 nm, 1300 nm 
SM: 1310 nm, 1550 nm 

Transmitter Laser Type 
MM 850 nm: 
MM 1300 nm: 
SM 1310 nm: 
SM 1550 nm: 

 
VCSEL 
Fabry-Perot MCW (Grin Lens Focused) 
Fabry-Perot MCW (Grin Lens Focused) 
Fabry-Perot MCW (Grin Lens Focused) 

Measurement Accuracy 
Attenuation: 
 
Length: 

 
MM 850/1300 nm: 
SM 1310/1550 nm: 
(+/- 3%) + 1 meter 

 
0.25 dB 
0.25 dB 

Display Resolution 
Attenuation: 
 
Length: 

 

 
MM 850/1300 nm: 
SM 1310/1550 nm: 
MM 850/1300 nm: 
SM 1310/1550 nm: 

 
0.1 dB 
0.1 dB 
1.0 meter 
1.0 meter 

Linearity 0.2 dB 

Length Range 
 
 
 

MM 850 nm: 
MM 1300 nm: 
SM 1310 nm: 
SM 1550 nm: 

3,000 meters 
6,000 meters 
10,000 meters 
10,000 meters 
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Table 1-3: FIBERTEK Performance Specification (Continued) 
 

Specifications FIBERTEKTM

Minimum Length 5 meters 

Physical 
Operating Temperature: 
Ambient Airflow: 

 
18 to 30oC at Specified Accuracy 
0.3 Ms @ 20oC 

Network Specifications 
 
 

1000BASE-SX/LX 
1000BASE-F 
10BASE-FL/FB 

IEEE-802.3z 
ATM-155/622 

 

 

Table 1-4: TRACETEK Performance Specification 

Specifications TRACETEKTM

Detector  

Center Wavelength: 1300 nm, 1310 nm 

Minimum Reflection for Event Detection: -40 dB 

Detector Type: INGaAs 

Distances  

High Resolution: 800 meters 

Medium Resolution: 850 meters 

Low Resolution: 4000 meters 

Distance Accuracy: (+/- 3%) + 1 meter 

Event Spatial Resolution: 2 meters – High Resolution 
8 meters – Medium and Low Resolution 

Display Resolution: 0.01 meter 

Transmitters  

MM Power Output: 40mW, (+16.0 dBm) 

MM Source Type: 1300 nm Fabry-Perot Laser 

SM Power Output: 20mW, (+13.0 dBm) 

SM Source Type: 1310 nm Fabry-Perot Laser 
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THE DISPLAY HANDSET (DH) 

The LANTEK Display Handset performs as the command unit to control preference and 
test functions during various cable test activities. 

DISPLAY CONTROLS, INDICATORS AND INTERFACE 

  

Figure 1-1: Display Handset (DH) 

Table 1-5: Display Handset (DH) Keys, LCD, and Connectors  

Item DH Front Panel Description 

1 Graphical Display Presents menus, test results, graphs, action choices, and 
option keys. 

2 Option Keys  Select menu options displayed on screen. 

3 Arrow/Enter Keys Allow up, down, left, and right movement on the display. 
Enter key selects a highlighted option or saves changes. 

4 AUTOTEST Key Perform a fast suite of tests. Test results are presented as 
pass/fail. Suites for established standards are 
preprogrammed in the tester. 

5 Wiremap Key Find shorts, opens, and miswires such as split and reversed 
pairs. 

6 Length/TDR Key Initiate a Length or TDR. 

7 Talk/Analyze Key Activate/deactivate the Talkset function or Select option to 
perform individual cable tests (real time). 

8 Help/Setup Key Display Help info or open language setup screen 

9 Escape Key Abort and exit the current screen without making changes. 
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Item DH Front Panel Description 

10 Alphanumeric Keys Enter numbers, letters or special characters.  Select 
numbered menu options. 

11 Shift Key Toggle key activities having dual functions. 

12 Backlight Key Toggle the screen backlight on/off. 

13 On/Off Switch Power the Display Handset on/off. 

14 Low-Crosstalk 
Connector Port 

Attach adapters for all types of cables. 

15 Talkset Jack Connect a Talkset headset and microphone. 

16 DC Input Jack Connect an external power supply. 

17 PCMCIA Slots Insert memory cards for data storage. See Removable Mass 
Storage below. 

18 USB Port Supports the following functions: 
Upload stored test results to a PC. 
Load firmware updates. 

19 DB-9 Serial Port Supports the following functions:  
Print test results on a serial printer. 
Upload stored test results to a PC. 
Load firmware updates. 

 

Removable Mass Storage 

  Caution: When removing the Compact Flash card from its slot as sustained 
usage will cause the card to become hot to the touch. This condition does not affect 
the operation of the card. 

The LANTEK tester provides two PCMCIA slots (Slot 1/Slot 2) for Compact Flash 
memory, which can be used for storing test results. Storage is organized in a standard 
Windows file structure with folder names corresponding to job names containing the 
test data files. 

The storage system can accommodate Compact Flash memory up to 256 MB. The 
firmware will automatically present the option of moving test data from the internal 
memory to the Compact Flash, if the flash card is installed. The stored test data from 
the flash card can be transferred to a PC or laptop through the use of a flash card 
reader. 
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1/4 VGA FRONT PANEL 

The Ready screen appears when the unit is powered up.  

Note: A “Field Calibration is Required” screen will appear if the test being performed 
requires a field calibration prior to testing.  

 

Figure 1-2: LCD Ready Screen 

 
Table 1-6: Ready Screen Indicators 

Item Function Description 

1 Battery Meter, or 
AC Cable 

Display remaining battery power level (from Empty to 
Full) or indicates when the unit is running off AC power. 

2 Talk Set Indicator Indicate when the Talk Set function is available. 

Display whether Compact Flash Memory or alternate 
device is used to store data. Also indicates the total 
number of records stored. 

3 Storage Device 
Indicator and Memory 
Usage 

4 Screen Title Display the screen title. 

5 Time and Date Display time and date information. 

6 Setting Display the cable type selected for testing. 

7 Job Title Display the current job name. 

8 Function Title Display the title of the highlighted function. 

9 Cable ID Icon Select the cable naming function. 

10 Stored Test Icon Select the stored test file manager function. 

11 Field Calibration Icon Select the field calibration function. 

12 Preferences Icon Select the instrument preferences function. 

13 Instrument Information 
Icon 

Select the instrument information function. 

14 Analyze Icon Select the option to perform individual cable tests (real 
time). 

15 Fiber Optics Icon Select the fiber optics function. 

16 Cable Type Icon Select or edit a cable type. 
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HARD AND SOFT KEYS 

User options will often appear at the bottom of the tester display screen above the 
four function keys (F1 to F4) directly below the display. To select an action, press its 
corresponding function key. Pressing and hold down the SHIFT key while 
simultaneously pressing one of the F1 to F4 keys will activate the F5 to F8 keys. 
(Example <SHIFT>F4 is the F8 key.) 

In the example below, press the Function keys below the screen to adjust the Timeout 
options: F1 to increase or F2 to decrease. 

 
 
 
 
 
 
 

Soft Keys 

 

    
Function Keys  

 
 

Table 1-7: Soft Key Descriptions 

Soft Key Description 

    

 

Delete alphanumeric character(s) at the cursor; delete left of the 
cursor; and insert alphanumeric character(s) at the cursor 

    
Automatic naming function on the near-end and far-end 

 
Show a list of options to select from 

 
Begin or Run the selected activity 

    
Accept the new changes upon exiting the activity; or exits without 
making changes 

 
Selection of USB mode 

Save data to the current file or use the auto naming convention; 
and rename or overwrite on existing file     

Print data 
 

 
Show a list of manufactured cables used to set the correct NVP 
value 

 
Create a Custom Cable 

 
Display/Set Nominal Velocity of Propagation 

    
Page-up/down or increase/decrease values 
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Table 1-7: Soft Key Descriptions (Continued) 
 

Soft Key Description 

    

    

Increase/Decrease values by 1 and 10 units 

    
Time format in 12 or 24 hours 

    
Measurement in feet or meters 

    
Settings in Manual or Automatic 

 
Calculates a new NVP value with known length of cable 

Shrinks or Magnifies graph view 
    

 
Overwrites the highlighted data entry 

 
Activates or deactivates the highlighted option 

 
Edits existing data previous recorded 

 
Runs the selected activity 

 
Automatically scans and identifies storage media for use and 
refreshes info 

Changes Reference Temperature 
 

Changes color wiremap display (568 A/B) 
 

 
Show list of Fiber Optic Cabling Standards & Applications 

 
Manually enter value for Fiber Budget Loss Computation 

 
Calculate for value of budget loss 

    
Display the worst case values or margins 

 
 

THE REMOTE HANDSET (RH) 

The Remote Handset works with the DH (Display Handset) to perform Autotest or 
individual real time Analyze tests. The RH terminates the cable link and communicates 
with the DH. When performing measurements, the RH is automatically activated by 
the DH.  

Note: The RH needs to have power available when performing a field calibration, 
otherwise, the DH will not find it. 
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DISPLAY, CONTROLS, INDICATORS AND INTERFACE 

  

Figure 1-3: Remote Handset (RH) 

 
Table 1-8: Remote Handset (RH) Keys, LED, and Connectors 

Item RH Front Panel Description 

1 B/W LCD Two line alphanumeric display 

2 Hazard LED Excessive line voltage present (TELCO) 

3 Pass LED Successful test results 

4 Fail LED Unsuccessful test result(s) 

5 On LED RH unit on 

6 Autotest Key Press to activate Autotest 

7 Escape Key Abort and exit the current activity without 
making changes. 

8 Tone Key Press to activate/deactivate Tone 

9 Talk Key Press to activate/deactivate Talkset 

10 Shift Key Toggle key activities having dual functions 

11 Backlight Key Screen backlight, unused 

12 On/Off Switch Power the Remote Handset on/off 

13 Low-Crosstalk Connector Port Test access cable connector 

14 Talkset Jack Connect a Talkset headset and microphone 

15 DC Input Jack Connect an external power supply 

16 DB-9 Serial Port Interface to a PC or serial printer 

17 USB Port Interface to a PC 
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POWER MANAGEMENT 

Both the Display (DH) and Remote (RH) Handsets use interchangeable rechargeable 
NiMH (Nickel Metal-Hydride) battery packs.  

 The DH and RH can be run on battery power for approximately eight hours. 
Actual battery power times will vary based on factors such as operating time 
versus standby time, use of the display backlight, and ambient temperature. 

 When the battery is almost empty, the tester displays a warning message. The 
tester will automatically shut down before testing results are affected. 

 After a brief period of inactivity, the DH and RH automatically power down to 
save battery power. 

 If the tester will not be used for several days, it is recommended that the yellow 
battery protection strips be inserted to conserve battery charge. 

 

OPERATING THE DH AND RH FROM AC POWER 

The DH and RH handsets can be operated from an external DC source (AC/DC Wall 
Cube). 

 

Figure 1-4: Tester AC/DC Wall Cube Adapter 

When the AC/DC Wall Cube Adapter is used to power the handsets: 

 Both handset batteries will receive a trickle charge. 

 The DH handset will display the AC plug and cable indicator at the top left of the 
screen. 

 

 

Only the Wall Cube provided with the instrument should be used. Other 
types of Wall Cubes may cause damage to the tester. Adapters are 
currently available for European, United Kingdom and North American 
AC power. 

Note: Do not connect to AC power when testing shielded cables as a ground, loop 
may result and cause input protection warnings. 

BATTERY CHARGING 

The handset batteries are recharged using the AC/DC Wall Cube. The process can take 
up to approximately 8 hours to fully recharge batteries. The DH uses battery-powered 
flash ROM to store handset data and settings whenever the battery is removed from 
the tester. The internal flash ROM battery has a three-year life expectancy. 

Note:  Charge time will vary depending upon battery level at the time of charging. 
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OVERVIEW OF LINK TESTING AND REQUIREMENTS 

The following sections describe typical setup for permanent link and channel link 
testing. Specific requirements for calibration of copper, coax, and fiber testing are 
discussed in Chapter 3: Structured Cable Field Calibration and Testing, Chapter 4: 
Coax Cable Field Calibration and Testing, and Chapter 5: Fiber Optics Cable Field 
Calibration and Testing (FIBERTEK )TM . 

PERMANENT LINK TEST SETUP 

ANSI, EIA, TIA, and ISO all provide two network communication circuit specifications: 
permanent link and channel link. A permanent link consists of up to 90 meters of 
horizontal network cabling (maximum length limit applies to TIA standards only). The 
permanent link (shown below) is used to certify the horizontal network cable 
installation before network connection and user hookup. It excludes adapters, 
patchcords, and jumpers. 

CHANNEL LINK TEST SETUP 

A channel link includes all aspects of the cabling system. It consists of up to 90 meters 
of horizontal network cabling, as well as user patchcords, jumpers, and channel 
adapters at each end. The channel link (shown below) is used to certify the network 
installation, including the horizontal link and user patchcords. 

 

Figure 1-5: Permanent Link Test Connections 

Note: Ensure that the Cable Type is set to the correct testing links. Twisted Pair 
Permanent Link or Twisted Pair Channel Link. If you exceed the tester length limits, 
the tester will fail the link. 

 

 

 



 

CHAPTER 2 
CABLE SETUP PROCEDURES 

 

SETTING PREFERENCES 

Most of the tester configuration parameters are set from the Preferences screen. 

To open the Preferences screen: 

1. Select Preferences on the Ready screen.  The Preferences screen appears. 

  

Figure 2-1: Preferences Screen 

2. Use the UP/DOWN ARROW keys to select one or more options. These options 
are described in the sub-sections below. 

USER INFORMATION 

User information identifies the unit operator for test reports. 

3. Select User Information on the Preferences screen. The User Information screen 
appears. 

 

Figure 2-2: User Information Screen 

4. Use the ALPHA/NUMERIC keys to enter your name. Press the LEFT/RIGHT 
ARROW keys to move the cursor from one character to the next. 

5. Use the UP/DOWN ARROW keys to move between the fields.  

6. Press ENTER to save or ESCAPE to exit. 
Note: In most screens, press ESCAPE, the user will have the option to save or not 
save the changes selected during this procedure. 
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AUTOTEST PREFERENCES 

Autotest can be set to automatically stop on the first failed test, as well as to save, 
and name test results at the completion of each test series. 

1. Select Autotest Preferences on the Preferences screen. Press ENTER. The Autotest 
Preference screen appears. 

2. Press the UP/DOWN ARROW keys to highlight the desired option. 

3. Press  to activate or deactivate the highlighted option. 

  

Figure 2-3: Autotest Preference Screen 

4. Press ENTER to save or ESCAPE to exit. 

 

Table 2-1: Autotest Preference Options 

Option Action 

Simple Cable ID Assign a fixed alpha value for the Cable ID. 

Stop on Fail Autotest aborts at the first failed test. Otherwise, Autotest continues until all 
tests are completed, regardless of results.  

Note: If a wire map cannot be completed due to gross miss-wiring, the Autotest 
may abort regardless of the setting of this preference. 

AutoSave Autotest automatically names and saves any passed AUTOTEST results.  Failed 
tests are not automatically saved.  

Save Graphs Displaying graphs on the DH requires data to be transferred from the RH to the 
DH. To save time during testing, do not select this option.  

Note: De-selecting this option will not allow graphs to be loaded to the PC 
software or printed on certification reports. 

Auto Increment Autotest automatically increments Single and Double Cable ID test counters. 

Confirm Delete Activate request to confirm any Delete operation. 

Disable Fiber 
Autotest Length 

Disable or enable fiber Autotest length procedure. 

Enable 606A Enable 606-A Cable ID naming standard. 

Dim Backlight Toggle illumination of screen display backlighting during Autotest. 
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Table 2-1: Autotest Preference Options (continued) 

Option Action 

Enable Tera to 
Tera Mode 

LANTEK is set to default with Tera-to-Tera enable mode. 
In this mode, LANTEK firmware assumes that there is Tera-to-Tera 
patchcords connected and will treat an Autotest as a Cat 7 Autotest. 
If unselected, LANTEK firmware will assume that there is Tera-to-RJ45 
patchcords attached and the Autotest will be treated as a Cat 6 Autotest. 

Enable Wiremap 
on Failed Autotest 

Mode dictates whether or not the LANTEK will automatically enter the advanced 
failure analysis when an Autotest fails. 

 

CONTRAST 

1. Select Contrast on the Preferences screen. Press ENTER. The Contrast screen 
appears. 

2. Select  /  or  /  to adjust the screen contrast. 

 

Figure 2-4: Contrast Screen 

3. Press ENTER to save or ESCAPE to exit. 

 

 2-3 
 



Chapter 2  
Test Setup Procedures 

 

 

TIMEOUT OPTIONS 

Set time-out options to help conserve battery power when the tester is not in use.  

Default Timeout Settings: 

Backlight 1 minute 

Power 30 minutes 

 
1. Select Timeout Options on the Preferences screen. Press ENTER. The Timeout 

Options screen appears with the cursor on the Backlight Timeout option. 
Note: The timers begin counting from the last key press. 

2. Press the ARROW Keys to highlight the desired parameters. 

3. Select  or  to adjust the desired setting. 

 

Figure 2-5: Timeout Options Screen 

4. Press ENTER to save or ESCAPE to exit. 

 

MEASUREMENT UNITS 

Use this option to set the unit of measurement parameter for length measurements. 
The default setting is feet. 

1. Select Measurement Units on the Preferences screen. Press ENTER. The 
Measurement Units screen appears. 

2. Select either  or  to set the unit of measure to feet or meters. 

 

Figure 2-6: Measurement Units Screen 
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3. Press ENTER to save or ESCAPE to exit. 
Note: Refer to the following conversion for differences in measurement units:  
1 meter = 3.28084 ft 
1 foot = 0.3048006 m 

BAUD RATE 

When using the RS-232 serial port, this option can configure the baud rate at which 
information will be transmitted.   

1. Select Baud Rate on the Preferences screen. Press ENTER. The Baud Rate screen 
appears. 

 

Figure 2-7: Baud Rate Screen 

2. Select  or  to choose the desired setting. 

3. Press ENTER to save or ESCAPE to exit. 

 

TALKSET 

LANTEK testers are “Talkset ready.”  Use this option to configure communications 
between the Display Handset and the Remote Handset through an externally attached 
microphone/headset. 

To talk with someone using the talkset, both the Display Handset and the Remote 
Handset must be connected to a cable. 

If the Talkset is set to “Auto,” the Talkset feature is automatically enabled when 
Autotest is not running.  If the Talkset is set to “Manual,” the TALK button must be 
pressed momentarily to enable the Talkset feature. 

The units will remain in “Talk” mode until the ESCAPE button on either unit is 
pressed, the AUTOTEST button is pressed, or after a period of no talk activity is 
detected by the Display Handset. 

1. Select Talkset on the Preferences screen. Press ENTER. The Talkset screen 
appears. 

2. Press the ARROW keys to highlight the desired setting. 

3. The default setting for Talkset is “Manual”. Select  or  to select the 
desired setting. 
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Figure 2-8: Talkset Screens 

4. If the talkset is in Manual setting, select  /  or  /  to 
adjust the audible volume. 

5. Press ENTER to save or ESCAPE to exit. 

 

DATE AND TIME 

Accurate date and time settings are necessary to create reliable record and report 
information. 

1. Select Date and Time on the Preferences screen. Press ENTER. The Date and Time 
screen appears. 

2. Select  or  to select the desired time format setting. 

3. Use the ARROW keys to highlight the parameter to be changed. 

4. Press or select the ALPHA/NUMERIC or SOFT keys to enter the desired setting. 

5. Repeat steps 2 and 3 until all of the desired parameters have been set. 

6. Press ENTER to save or ESCAPE to exit. 

 

Figure 2-9: Date and Time Screen 
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LANGUAGE 

The following languages are built into the LANTEK: 

Chinese Czech  Deutsch 
Dutch English Espanol  
French Italian Korean 
Norwegian Polish Portuguese 
Russian   

 
1. Select Language on the Preferences screen. Press ENTER. The Language screen 

appears. 

2. Select  or  to select the desired language. 

3. Press ENTER to save or ESCAPE to exit. 

 

Figure 2-10: Language Screen 

Note: Press <SHIFT>SET-UP keys to quickly access the Language menu. 

RESTORE DEFAULTS 

Use this option to reset all unit settings to their factory defaults. 

1. From the Preferences screen, press the ARROW keys to highlight Restore 
Defaults. 

2. Press ENTER to restore the unit to the factory default settings. 

3. A Warning screen will appear. Select  to accept the changes or select 

 to exit this screen without making changes. 

 

Figure 2-11: Restore Defaults Warning Screen 
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PACK MEMORY 

Use this option to clear the tester memory of test(s) marked for deletion in the Stored 
Results screen. 

Note: Using Pack Memory is similar to emptying the “Recycle Bin” on your computer. 
No active records will be deleted. 

1. From the Preferences screen, press the ARROW keys to highlight Pack Memory. 

2. Press ENTER to clear the tester memory of scheduled deletions. 

3. A Warning screen will appear. Select  to accept the changes or select 

 to exit this screen without making changes. 

 

Figure 2-12: Pack Memory Warning Screen 

CLEAR MEMORY 

Use this option to clear the tester memory of all data. 

1. From the Preferences screen, press the ARROW keys to highlight Clear Memory. 

2. Press ENTER to clear the tester memory. 

3. A Warning screen will appear. Select  to accept the changes or select 

 to exit this screen without making changes. 

 

Figure 2-13: Clear Memory Warning Screen 

  Warning: There is NO UNDELETE option when Clear Memory is used. All stored 
tests will be permanently deleted. 
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SELECT SAVE MEDIA 

Use this option to select the type of tester storage memory to use. 

1. From the Preferences screen, press the ARROW keys to highlight Select Save 
Media. 

2. Press ENTER, the Select Save Media screen appears. 

3. Use  to automatically scan and identify all storage media operating within 
the DH. 

 

Figure 2-14: Select Save Media Screen 

4. Highlight the desired saving option and press ENTER to save or ESCAPE to exit 
without saving changes. 

 

WIREMAP COLOR SCHEME 

Use this option to select the type of wiremap color scheme to use. 

1. From the Preferences screen, press the ARROW keys to highlight Wiremap Color 
Scheme. 

2. Press ENTER. The Wiremap Color Scheme screen appears. 

3. Use the F1, F2, F3, or <SHIFT>F2 Keys to select either STD, 568-A, 568-B, or 
Tera type cable. 

4. Press F4 to save selection.  

  

Figure 2-15: Wiremap Color Scheme Screen 

5. Press ENTER to save or ESCAPE to exit without saving changes. 
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TEMPERATURE 

Use this option to select the temperature to use. 

Note: This feature is a legacy option for early Category 6 installations where the 
ambient temperature was considered during cable certification. 

1. From the Preferences screen, press the ARROW keys to highlight Temperature. 

2. Press ENTER. The Temperature screen appears. 

3. Select  or  to choose either Fahrenheit or Celsius. 

4. Press ENTER to save or ESCAPE to exit. 
Note: Refer to the following equations for differences in temperature conversion:  
Celsius = (TempFahrenheit – 32*5/9) 
Fahrenheit = (9/5* TempCelsius) + 32. 

 

Figure 2-16: Temperature Screen 

 

CABLE ID/AUTO AND 606 INCREMENT OPTIONS 

There are two type of cable naming available:  

 Simple Cable ID: Only the cable name and current value can be changed. 

 Standard Cable ID: Additionally, the counting range may be defined and 
individual digits may be locked. 

The type of cable naming is selected from the Preferences screen under Autotest 
Preferences. 

SIMPLE ID 

Selecting the Simple ID Option 

1. Select Autotest Preferences on the Preference screen. The Autotest Preferences 
screen appears. 

2. Press the ARROW keys to highlight Simple Cable ID. 

3. Press  to activate the Simple Cable ID. 
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STANDARD CABLE ID 

If the Simple Cable ID option is not activated in the Preferences screen under Autotest 
Preference, you have further options available to set the required cable. 

Setting a Cable ID 

1. In the Cable ID screen, highlight Set ‘Cable From’. 

  

Figure 2-17: Cable ID Screens 

2. Press ENTER to open the screen. 
Note: The screen that appears will reflect the most recently assigned Cable ID (either 
Single or Double). Double ID is used in this example. 

3. Enter the following parameters as required: 

a. ‘Cable From’ name, twelve (12) characters maximum. 
b. Current, Start, and End point of the counter, four digits each. After reaching the 
End point the counter will be reset. 

c. Select the  icon to activate a lock and  to activate the Auto Increment 
feature for a character.  

 Select  to go to the ‘Cable To’ screen. Repeat steps a, b and c. 

4. After entering the desired ‘Cable From’ and ‘Cable To’ names and parameters, 
press ENTER to save and return to the Main Cable ID screen. 

Test Counter 

In addition to the cable name, you can assign up to four characters to identify 
individual tests.  

 The icon  below a digit designates a non-incrementing field.  

 The icon  indicates an automatically incrementing field.  
 

The default numbering scheme is set to starts counting from 0000 and ends at 9999. 
Custom numbering schemes may be used. Table 2-2 and Table 2-3 contain some 
examples for counting Single and Double IDs.  
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Table 2-2: Single ID Counting Examples 

Preset Parameters  Custom Settings  
Cable Name: TEST Cable Name: PANEL Cable Name: PANEL 
Start: 0  0  0  0 
End: 9  9  9  9 
Lock:  
Current: 0  0  0  0 

Start: 0  0  0  0 
End: 0  0  2  2 
Lock:  
Current: 0  0  0  0 

Start: 0  0  0  A 
End: 0  9  9  D 
Lock:     
Current: 0  1  8  A 

0  0  0  0 0  0  0  0 0  1  8  A 
0  0  0  1 0  0  0  1 0  1  8  B 
0  0  0  2 0  0  0  2 0  1  8  C 
0  0  0  3 0  0  1  0 0  1  8  D 
0  0  0  4 0  0  1  1 0  1  9  A 
0  0  0  5 0  0  1  2 0  1  9  B 
0  0  0  6 0  0  2  0 0  1  9  C 
0  0  0  7 0  0  2  1 0  1  9  D 
0  0  0  8 0  0  2  2 0  2  0  A 
0  0  0  9 0  0  0  0 0  2  0  B 
0  0  1  0 0  0  0  1 0  2  0  C 
0  0  1  1 0  0  0  2 0  2  0  D 
0  0  1  2 0  0  1  0 0  2  1  A 

 
 

Table 2-3: Double ID Counting Examples 

“Cable To”  “Cable From” 

Cable name: OFFICE  Cable name: DISTRIB 

Counter  Counter 

Start: 0  0  0  A 
End: 0  0  9  D 
Lock:  
Current: 0  0  0  A 

 Start: 0  0  0  0 
End: 9  9  9  9 
Lock:  
Current: 0  0  0  0 

0  0  0  A  0  0  0  0 
0  0  0  B  0  0  0  1 
0  0  0  C  0  0  0  2 
0  0  0  D  0  0  0  3 
0  0  1  A  0  0  0  4 
0  0  1  B  0  0  0  5 
0  0  1  C  0  0  0  6 
0  0  1  D  0  0  0  7 
0  0  2  A  0  0  0  8 
0  0  2  B  0  0  0  9 
0  0  2  C  0  0  1  0 
0  0  2  D  0  0  1  1 
0  0  3  A  0  0  1  2 
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SETTING LANTEK TO TIA/EIA 606-A STANDARDS FORMAT 

The TIA/EIA 606-A standards for telecommunications infrastructures include the 
following elements: 

 Horizontal pathways and cabling, 

 Backbone pathways and cabling, 

 Telecommunications grounding/bonding, 

 Spaces (e.g., entrance facility, telecommunications room, equipment room), and  

 Firestopping. 
 

These Standards address the administration of telecommunications infrastructure by:  

 Assigning identifiers to components of the infrastructure, 

 Specifying elements of information which make up the infrastructure, 

 Specifying relationships between these records to access the information they 
contain, 

 Specifying reports presenting information on groups of records, and  

 Specifying graphical and symbolic requirements. 

 

Selecting Autotest Preferences to perform TIA/EIA 606-A Standards 

1. From the Preferences screen, use the UP/DOWN ARROW keys to select Autotest 
Preferences. Press ENTER. The Autotest Preferences screen appears. 

2. From the Autotest Preferences screen, use the UP/DOWN ARROW keys to select 
Enable 606A. 

 

Figure 2-18: Autotest Pref Screen – Enable 606A Selected 

3. Press  to highlight the box green. 

4. Press ENTER to save or ESCAPE to exit. 
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Saving in TIA/EIA 606A Format 

1. Once the Enable 606A selection process has been completed, press AUTOTEST to 
begin. 
Note: LANTEK uses the Standards format to apply identification to the cables and 
their infrastructure relationship. 

2. At completion of the Autotest activity, select one of three cable parameters (Drop, 
Backbone or Backbone Pair) to set the cable name for saving the results. Cable 
naming can be completed using the Auto Increment feature or manually. 

     

Figure 2-19: TIA 606A Cable Parameter Screens 

3. Press ENTER to save the cable name and results or ESCAPE to exit. 

4. If Enable 606A is selected in the Autotest Preference, then a 606A Standards Cable 
parameter can be edited by pressing F1 or selecting the Cable ID on the DH Ready 
Screen.  

 

DUALMODE 

The DUALmodeTM feature on the LANTEK is designed to provide both Permanent Link 
and Channel Link test results in about the same time that it would take to do each 
Autotest separately. For Category 6, that means both Channel and Permanent Link 
results are obtained and stored in about 20 seconds.  

Based on the patent-pending technique that LANTEK uses to produce Permanent Link 
results, the dual mode adapters physically resemble Channel Adapters and patchcords 
that gather both phase and magnitude data for the full channel. The LANTEK Cable 
Certifier process removes the patchcords losses and signal reflections to produce 
Permanent Link results. The DUALmode function saves the results in two separate 
records.  

Other significant tests can be performed under the DUALmode process. For example, 
consider the case where you, the installer, have a job to install a Category 6 class 
system in a government installation in a country that uses an ISO-based National 
Standard. You use cable and connectivity manufactured by a US-based company. The 
government may require the installer to certify the ISO-based CLASS E standard but 
the US Company may require certification to the TIA 568 Category 6 Standard in order 
to issue a warranty. Previously, this might have required running both ISO and TIA 
certifications and passing the increased costs to your client, the buyer. But with 
DUALmode, certifications to ISO CLASS E Permanent Link and TIA 568B Category 6 
can be performed at the same time with no more effort than running only one test. 
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Another example of performing DUALmode would be the determination of headroom 
with regards to higher bandwidth for future applications. Previously, you could visually 
inspect Category 5e Permanent Link Certification records and assess whether there is 
enough headroom to run the higher bandwidth applications. But in order to access 
complete definitive data, a Category 6 certification tests would also be required. These 
actions would normally be ignored due to the increased testing costs.  

With DUALmode, you could require that the system be certified to Category 5e 
Standards and that the system also be tested against the Category 6 limits. That way, 
in the future, your client would have definitive data about which of the links could 
support higher bandwidth applications. This information would be essential in any 
decision to re-terminate links using higher Category jacks or to pull higher category 
cable. 

PERFORMING IN DUALMODE: 

1. Move the cursor to select the Cable Type and press ENTER. The Cable Type screen 
appears. 

2. Move the cursor to Twisted Pair DUALmode and press ENTER. The DUALmode 
tests menu appears. 

3. Select the two (2) cable type combination to be tested in DUALmode and press 
ENTER. 

4. Press AUTOTEST. The PASS/FAIL results will be displayed. (Figure 2-20) 
Worst-case margins and values for NEXT, RL, ACR and Attenuation are shown for 
each of the DUALmode tests. 

 

Figure 2-20: DUALmode Autotest  

5. Press ENTER on the highlighted test to display its related graphic results. 
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OTHER OPERATIONS 

CHANGING DEFAULT NVP VALUE OF A CABLE 

1. From the Test Standard screen, select  to change the NVP. The NVP screen 
will appear. 

 

Figure 2-21: NVP Screen 

2. Use the ALPHA/NUMERIC keys to manually enter one or more NVP value(s). 

3. To automatically calculate a new NVP value, select . The Measure NVP 
screen appears. 

4. Connect a test cable of known length. 

5. Using the ARROW and NUMERIC keys, enter the known cable length. 

6. Select  to calculate a new NVP value. The display returns to the main NVP 
screen after the new NVP value has been calculated. 
Note: This is a channel measurement. Include the length of both patchcords when 
entering the cable length information. 

CHANGING THE DEFAULT REFERENCE TEMPERATURE (TREF) VALUE  

This function is typically used in very warm environments where cable performance 
degrades as temperature rises. Input the maximum expected temperature that the 
cable will be exposed to and the attenuation limits will changes accordingly. This 
ensures that the network will operate properly even in extreme heat. Be aware that 
the longer links may fail the autotest since the attenuation limits are more strict as 
higher temperature values are entered into the TREF function. 

1. From the Test Standard screen, select  to change the Reference 
Temperature. The Reference Temperature screen will appear. 

2. Use the ALPHA/NUMERIC keys to manually enter a new Reference Temperature 
Value. 

3. Press ENTER to accept the new Reference Temperature. 
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CUSTOM CABLE SETTINGS AND PARAMETERS 

All of the cable types pre-programmed into the LANTEK tester are associated with a 
predefined test standard. You cannot change these pre-programmed settings. If you 
want to run a different set of tests for a given cable you must create a Custom Cable.  

For example, if you would like to run Return Loss in addition to the TIA 568B Category 
5 tests (Return Loss is not a required TIA test), you must create a Custom Cable and 
select the tests you want to include in the test suite for this cable. 

A maximum of ten (10) custom cable settings can be created, stored, removed, and 
retrieved when needed. 

Creating a New Custom Cable Type 

1. Press <SHIFT>F4 or select the Cable Type on the DH Ready screen. The Cable 
Type screen appears. 

2. Press the ARROW keys to highlight the desired cable type. 

3. Press ENTER, the Test Standard screen appears with list of cable type names. 

4. Position the cursor over the desired cable type and select . The Custom 
Cable screen appears. 

5. Change the desired cable settings, and then proceed to the next step, naming the 
cable. 

6. Position the cursor over Custom Name/NVP and press ENTER. The NVP Screen 
appears. 

7. Change NVP parameters as required and then name your new custom cable. 

8. Press SAVE to accept the changes and return to the Custom Cable screen. 
The new custom cable is now selected as the cable under test. 

  

Figure 2-22: Custom Name/NVP Screen 

Selecting or Deleting a Custom Cable Type 

1. Press <SHIFT>F4 or select the Cable Type on the DH Ready screen. The Cable 
Type screen appears. 

2. Press the ARROW Key to highlight the Custom Cable type. 

3. Press ENTER to open the Custom Cable screen. 

4. Position the cursor over the desired custom cable type. 

5. Press ENTER to make the custom cable you highlighted the new cable type or 

select  to delete the selected custom cable type. 
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Editing an Existing Custom Cable Type 

1. Repeat Steps 1 to 3 from previous procedure. 

2. Select the cable type to be customized. 

3. Press the  soft key. The Custom Cable parameter screen appears. 

4. Highlight the desired custom cable parameter and press ENTER to edit the 
settings. 

5. After making the desired changes, select the Custom Name/NVP option. 
The NVP screen appears. 

6. Press ENTER to save the cable under its current name or under a new name. 
Note: Refer to the section below for a description of custom cable parameter options. 

Custom Cable Parameters 
 

 

Figure 2-23: Custom Cable Parameter Screen 

 
Table 2-4: Custom Cable Parameter Options 

Item Parameter Description 

1 Frequency Range Use this menu to set minimum and maximum certification 
and cable performance frequencies. 

2 Connector Pinout This screen is used to define connector pinouts.  
Note: If one wire pair is not selected, tests for NEXT, 
attenuation, capacitance, DC resistance, and impedance 
will not be performed on that pair. 

3 Test Limits This screen is used to customize Autotest pass/fail limits. 

4 Link Models Custom NEXT and Attenuation limits are set by using a 
flat line limit or one of several different models. 
Frequency limits will vary depending on the LANTEK 
model and link type. 

5 Select Autotests Not all cables will require the full suite of Autotests. Use 
this menu to select the Autotests to be performed. 

6 Custom Name/NVP Use the ALPHA/NUMERIC keys to enter a custom name 
or change the NVP parameters. The LANTEK testers can 
store up to 10 custom cables. 

2-18  
 



 Chapter 2 
Test Setup Procedures 

 

TONE GENERATOR 

Both the Display Handset and Remote Handset can generate a “low” tone, “high” tone, 
or “warble” tone (alternating “low” and “high” tone at 2 Hz rate) that is detectable by 
most standard wire tracing amplifiers.  

 

Figure 2-24: Typical Tone Generator Setup 

Note: The WIREMAP, SHIFT, and TONE buttons are hard keys. Pair A, Pair B, Pair C, 
Pair D, Low, High, and Warble are soft keys that appear on the Display Handset. 

ACTIVATING THE TONE GENERATOR USING THE DH 

1. Connect the Display Handset to the cable under test. 

2. Press <SHIFT>WIRE MAP to enter Tone mode.  
Note:  The Tone mode will remain active until ESCAPE is pressed. 

3. Using the soft keys, select the pair (Pair 78, Pair 36, Pair 54, or Pair 12) on which 
to place the tone. 

4. Select the tone, press SHIFT, and select LOW, HIGH, or WARBLE using the soft 
keys. 
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ACTIVATING THE TONE GENERATOR USING THE RH 

1. Connect the Remote Handset to the cable under test. 

2. Press TONE on the Remote Handset to enter Tone mode. The Remote Handset 
two-line display shows the first line TONE. The second line shows the tone type 
and placement of tone in the XY form of characters. 

 

X Character 
(Tone Type) 

Y Character 
(Placement of tone) 

L = Low 78 = Pair 78 

H = High 36 = Pair 36 

W = Warble 54 = Pair 54 

 12 = Pair 12 

 
Example: L78 = Low tone, Pair 78 

Note:  The Tone mode will remain active until ESCAPE is pressed. 

3. Select the pair on which to place the tone by pressing the TONE key to cycle 
through the options. 

4. Select the tone for the selected pair by pressing <SHIFT>TONE to cycle through 
the options. 
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CHAPTER 3 
STRUCTURED CABLE FIELD 

CALIBRATION AND TESTING 

 

FIELD CALIBRATION – CAT3/5E/6/6A AND CLASS C/D/E/Ea/F/Fa 
(TERA AND EC 7) 

This Field Calibration is a 4-step process. Steps 1 and 2 are performed with the 
patchcords connected to the Handsets. Steps 3 and 4 are performed with open-ended 
patchcords (Only one end connected to the Handsets). 

To calibrate the tester, perform the following: 

Step 1 

 Connect the adapters to the Display Handset (DH) and Remote Handset (RH). 

 Power both units on. 

 Connect the patchcord that you plan to use as the RH patchcord to the adapters 
of the DH and RH units.  

 From the DH Ready screen, select Field Calibration. The Calibration screen 
appears.  

 From the DH Field Calibration screen, select START to begin the calibration 
process on the first (RH) patchcord. This first process takes about 10-20 seconds 
to complete. 

 At the completion of the first calibration process, tag the RH end of the first 
patchcord. Disconnect the first patchcord from the DH and RH unit adapters. 
This tag will remind you which end to reinsert into the RH for Step 4.  

 

Step 2 

 Insert the second (DH) matching patchcord into both the DH and RH adapters.  

 From the DH Field Calibration screen, select START to begin the second 
calibration step. 

 At the completion of the second patchcord step, disconnect one end of the 
second patchcord from the RH unit adapter (leaving the second end still attached 
to the DH unit).  

 

 3-1 
 



Chapter 3 
 

 
Structured Cable Field Calibration and Testing
 

3-2  

 

 

Step 3 

 Re-insert the tagged end of the first patchcord into the RH unit adapter.  

 From the DH Field Calibration screen, select START or press AUTOTEST to 
begin the third calibration step.  

 

Step 4 

 From the RH, press AUTOTEST to begin the fourth calibration step. 

 If calibration is successful, the DH will briefly Display “Calibration Complete” and 
the RH will briefly display the PASS light.  

 If calibration is unsuccessful, the DH will briefly display either a Warning screen 
displaying “No Remote Handset” or a Calibration Failure screen. 

 

FIELD CALIBRATION - GG45 

This field calibration is a 4-step process. Steps 1 and 2 are performed with the GG45 
Calibration Adapters connected to the handsets. Steps 3 and 4 are performed with the 
GG45 Permanent Link Adapters open-ended patchcords and then the GG45 Calibration 
Load Terminator attached. 

The GG45 test kit comprises a Category 6/7 connector product that is backward 
compatible with Category 6 - RJ45s. 
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To calibrate the tester, perform the following: 

Steps 1 and 2 

 Connect the GG45 Calibration Adapters to the Display Handset (DH) and Remote 
Handset (RH). Power both units on. 

 From the DH Ready screen, select Field Calibration. The Calibration screen 
appears. 

 From the DH Field Calibration screen, select START to begin the first calibration 
process. When this process ends, select START again to perform the second 
calibration process. Each process will take about 10-20 seconds to complete. 

  

 At the completion of steps 1 and 2, disconnect the GG45 Calibration Adapters. 

Step 3 

 Insert the GG45 Permanent Link Adapters into both the Display and Remote 
Handsets. 

 From the DH Field Calibration screen, select START to begin the third calibration 
step. 

 Terminate the open end of the patchcord by connecting the GG45 Calibration 
Load Terminator and select START again. 

  

Step 4 

 From the RH, press AUTOTEST to begin the fourth calibration step.  

 Terminate the open end of the patchcord by connecting the GG45 Calibration 
Load Terminator and press AUTOTEST again. 

 When Step 4 is completed, the LANTEK is ready for testing Permanent Links. 

 

 



Chapter 3 
 

 
Structured Cable Field Calibration and Testing
 

3-4  

GG45 – TROUBLESHOOTING 

A field calibration should be performed prior to implementing a test of the GG45 
cabling system. This process will ensure (1) synchronizing of the units, (2) qualifying 
(testing) of the patchcords and (3) gathering of loss data regarding the patchcords 
and mated connections. 

The equipment required for a GG45 calibration procedure is: 

 Display Handset 

 Remote Handset 

 GG45 Calibration Adapters 
(Two adapters joined by a short segment of Category 7 cable) 

 GG45 Calibration Load Terminator (100Ω Jack) 

 GG45 Permanent Link Adapters 
(A set of two adapters, each with a patchcord (approximately 2 meters) soldered 
to the adapter at one end and a GG45 Category 7 plug at the opposite end) 

 

TESTING A GG45 CABLING SYSTEM  

 

 

Figure 3-1: Typical Configuration for GG45 Cable Testing 

Typical configuration for testing has the DH unit and RH unit connected to the GG45 
Permanent Link Adapters. The cable under test is connected at the Category 7 plug 
end of both the DH and RH ends. 
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FIELD CALIBRATION - PATCHCORD TESTING 

This Field Calibration is a 4-step process. Steps 1 and 2 are performed with the hybrid 
(RJ45 Plug to RJ45-TIA-Reference-Jack) patchcords connected to the Handsets using 
the kit’s mini patchcord. Steps 3 and 4 are performed with open-ended hybrid 
patchcords (Only one end connected to the Handsets). 

To calibrate the tester, perform the following: 

 

Step 1 

 Connect the Category 5e/6 – RJ45 adapters to the Display Handset (DH) and 
Remote Handset (RH). Power both units on.  

 Connect the RJ45 plug of the first hybrid patchcord to the Remote Handset (RH). 
Using the RJ45 mini patchcord attach the DH RJ45-TIA Reference Jack end of the 
hybrid patchcord to one end of the mini patchcord and then connect the other 
end of the mini patchcord to the Display Handset (DH). 

Note: Patchcords can vary in length. The most common length used is the 2-meter 
length patchcords. 

 From the DH Ready Screen, select Field Calibration. The Calibration screen 
appears. 

 From the RH, press AUTOTEST to perform the first step of the calibration 
process. At the completion of step 1, disconnect the mini patchcord and hybrid 
patchcord from the RH and DH. 

Step 2 

 Connect the RJ45 plug of the second hybrid patchcord to the Display Handset 
(DH). Using the RJ45 mini patchcord attach the DH  RJ45-TIA Reference Jack 
end of the hybrid patchcord to one end of the mini patchcord and then connect 
the other end of the mini patchcord to the Remote Handset (RH). 

 From the DH Field Calibration screen, select START or press AUTOTEST from 
the RH to perform the second step of the calibration process.  

 At the completion of step 2, disconnect the mini patchcord. 
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Step 3 

 Remove the RJ45 mini patchcord from the RH and the hybrid patchcord. 

 With the DH hybrid patchcord open-ended, select START from the DH Field 
Calibration screen to perform the third calibration process. 

Step 4 

 Re-connect the RJ45 plug of the first hybrid patchcords to the Remote Handset 
(RH). 

 With the RH hybrid patchcord open-ended, press AUTOTEST from the RH to 
perform the fourth calibration process. Upon completion of the calibration 
process, the LANTEK handsets and the hybrid patchcords are ready for use in 
testing cables. 

 

FIELD CALIBRATION - BLOCK TESTING 66/110/BIX 

This Field Calibration is a 4-step process. Steps 1 and 2 are performed with a 
patchcord connected to the Handsets. Steps 3 and 4 are performed with open-ended 
patchcords (only one end connected to each Handset). 

 

For Block 66 Systems 

The RJ45 block calibration adapters connected to the block during calibration is either 
the T568A or 568B RJ45/66 Block adapter. The T568A adapter is used with patchcords 
connected in a TIA-568A configuration. The T568B adapter is used with patchcords 
connected in a TIA-568B configuration. Both block adapters have the standard RJ45 
plug at the opposite end. 
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Calibrating the tester for the 110/BIX Block System: 

Step 1 and 2 

 Connect the adapters to the Display Handset (DH) and Remote Handset (RH). 
Power both units on. 

 Connect the RJ45-to-RJ45 patchcord that you plan to use as the RH patchcord to 
the adapters of the DH and RH units.  

 From the DH Ready screen, select Field Calibration. The Calibration screen 
appears. Select START to begin the calibration.  

 Select START again to perform the second calibration process. Each step will 
take about 10-20 seconds to complete.  

 At the completion of this calibration process disconnect the RJ45 patchcord from 
the DH unit, leaving the RJ45-to-RJ45 patchcord attached to the RH unit. 

Step 3 

 Insert the second (DH) RJ45 to Block Plug patchcord into the DH unit where the 
RJ45 end is connected into the DH unit adapter and the block plug is left open-
ended.  

 From the DH Field Calibration screen, select START or press AUTOTEST to 
begin the third calibration process. 

Step 4 

 From the RH, press AUTOTEST to begin the fourth calibration step.  

 If calibration is successful, the DH will briefly Display “Calibration Complete” and 
the RH will briefly display the PASS light. The handsets and the patchcords are 
now ready for testing procedures. 

 If calibration is unsuccessful, the DH will briefly display either a Warning screen 
displaying “No Remote Handset” or a Calibration Failure screen. 

 

Calibrating the tester for the 66 Block System: 

Steps 1 and 2 

 Connect the RJ45 adapters to the Display Handset (DH) and Remote Handset 
(RH). Power both units on. 

 Connect the RJ45-to-RJ45 Patchcord that you plan to use as the RH Patchcord to 
the adapters of the DH and RH units. 

 From the DH Ready screen, select Field Calibration. The Calibration screen 
appears. Select START to begin the calibration process on the (RH) Patchcord.  

 Then select START again to perform the calibration process. This will take about 
10-20 seconds to complete. 

 At the completion of this calibration process disconnect the RJ45 patchcord from 
the DH unit leaving the RJ45-to-RJ45 patchcord attached to the RH unit. 
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Step 3 

 Connect the RJ45/66 Block adapter to one end of the DH RJ45 patchcord. 
Note: If field testing a TIA-568A connection system, use a T568A calibration adapter. 
If field testing a TIA-568B connection system, use a T568B calibration adapter. 

 Insert the other end of the DH patchcord into the DH unit, leaving the block 
adapter connection open-ended.  

 From the DH Field Calibration screen, select START, or press AUTOTEST to 
perform the third calibration process. 

Step 4 

 Press AUTOTEST on the RH to perform the fourth calibration process. 

 If calibration is successful, the DH will briefly Display “Calibration Complete” and 
the RH will briefly display the PASS light. The handsets and the patchcords are 
now ready for testing procedures. 

 If calibration is unsuccessful, the DH will briefly display either a Warning screen 
displaying “No Remote Handset” or a Calibration Failure screen. 

AUTOTEST AND SINGLE TEST FOR STRUCTURED CABLE 

AUTOTEST SUITE OVERVIEW 

Autotest is the easiest and quickest way to measure and verify your cable installation. 
When the AUTOTEST key is pressed, the LANTEK tester automatically performs a 
series of pre-programmed tests. These test suites are pre-determined based on either 
adopted or proposed standards as well as specific parameters. After all tests have 
been completed, the tester displays a single overall pass/fail result and individual test 
pass/fail results. 

Autotests are performed with the Display Handset (DH) and Remote Handset (RH) 
connected at opposite ends of the cable under test.  

Test Suites 

Tests run during an Autotest depend on the cable type selected.  

Autotest can be preset to automatically save test results immediately following each 
suite of tests, or results can be saved and printed manually. To preset these functions, 
see Autotest Preferences.  

Individual sub-tests can be selected and viewed with more detailed data following 
completion of the Autotest using the Autotest Results screen. 
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Table 3-1: Preset Autotest Suites Available for Specific Cable Types 
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TWISTED PAIR PERMANENT
Cat 5E, UTP/STP Perm * * * * * * * * * * * *
Cat 6-250 UTP/STP Perm * * * * * * * * * * * * *
Cat 6 Midspan POE Perm * * * * * * * * * * * *
Cat 6 10GbE TSB155D 3.0 UTP/STP Perm * * * * * * * * * * * * *
Cat 6a 500 Draft 3.0 UTP/STP Perm * * * * * * * * * * * * *
ISO C UTP/STP 2nd Perm * * * * * * *
ISO D UTP/STP 2nd Perm * * * * * * * * * * * *
ISO E UTP/STP Perm * * * * * * * * * * * *
ISO Ea 500 Draft 753 UTP/STP Perm * * * * * * * * * * * *
ISO F 600 STP Perm * * * * * * * * * * * *
ISO F 350 STP Perm * * * * * * * * * * * *
EN50173-1 D UTP/STP Perm * * * * * * * * * * * *
EN50173-1 E UTP/STP Perm * * * * * * * * * * * *
EN50173-1 F 600 STP Perm * * * * * * * * * * * *
EN50173-1 F 350 STP Perm * * * * * * * * * * * *
EN50173.A1 D UTP/STP Perm * * * * * * * * * * * *
AS/NZS 3080 UTP/STP Perm * * * * * * * * * * * * * *
Graybar VIP 1000 UTP/STP Perm * * * * * * * * * * * *
Graybar VIP 2000 UTP/STP Perm * * * * * * * * * * * * *
Nexans LANmark D UTP/STP Perm * * * * * * * * * * * *
Nexans LANmark E UTP/STP Perm * * * * * * * * * * * * *
Nexans Epsilon E UTP/STP Perm * * * * * * * * * * * * *
Nexans Class D UTP/STP Perm * * * * * * * * * * * *
Korean Govt Residential Perm * * *
Korean Govt Commercial Perm * * *
TWISTED PAIR BASIC
Cat 3 UTP Link * * * *
Cat 5 UTP/STP Link * * * *
Cat 5 Gbit UTP/STP Link * * * * * * *
Cat 5E UTP/STP Link * * * * * * * * * * * *
ISO C UTP/STP 1st Link * * * * * * * *
ISO D UTP/STP 1.2 Link * * * * * * * *
TPPMD UTP Link * * * * * * * * *
TPDDI STP Link * * * * * * * * *
AS/NZS C UTP/STP Link * * * * * * * * * *
AS/NZS D UTP/STP Link * * * * * * * * * *
BOSCH STP Link * * * * * * * * * *
BOSCH 120S Link * * * * * * * * *
TWISTED PAIR CHANNEL
Cat 3 UTP Chan * * * *
Cat 5 UTP/STP Chan * * * *
Cat 5 Gbit UTP/STP Chan * * * * * * *
Cat 5E UTP/STP Chan * * * * * * * * * * * *
Cat 6-250 UTP/STP Chan * * * * * * * * * * * * *
Cat 6 Midspan POE Chan * * * * * * * * * * * *
Cat 6 10GbE TSB155D 1.3.2 UTP/STP Chan * * * * * * * * * * * * *
Cat 6a 500 Draft 3.0 UTP/STP Chan * * * * * * * * * * * * *  
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TWISTED PAIR CHANNEL
ISO C UTP/STP 2nd Chan * * * * * * *
ISO D UTP/STP 1.2 Chan * * * * * * * *
ISO D UTP/STP 2nd Chan * * * * * * * * * * * *
ISO E UTP/STP Chan * * * * * * * * * * * *
ISO Ea 500 Draft 753 UTP/STP Chan * * * * * * * * * * * *
ISO E 10GbE Draft 762 UTP/STP Chan * * * * * * * * * * * *
ISO TR24750 Draft 762 UTP/STP Chan * * * * * * * * * * * *
ISO F 600 STP Chan * * * * * * * * * * * *
ISO F 350 STP Chan * * * * * * * * * * * *
EN50173-1 D UTP/STP Chan * * * * * * * * * * * *
EN50173-1 E UTP/STP Chan * * * * * * * * * * * *
EN50173-1 F 600 STP Chan * * * * * * * * * * * *
EN50173-1 F 350 STP Chan * * * * * * * * * * * *
EN50173.A1 C UTP Chan * * * * * * *
EN50173.A1 D UTP/STP Chan * * * * * * * * * * * *
AS/NZS C UTP/STP Chan * * * * * * * * * *
AS/NZS D UTP/STP Chan * * * * * * * * *
BOSCH STP Chan * * * * * * * * *
BOSCH 120S Chan * * * * * * * *
Graybar VIP 1000 UTP/STP Chan * * * * * * * * * * *
Graybar VIP 2000 UTP/STP Chan * * * * * * * * * * * * *
Korean Govt Residential Chan * * *
Korean Govt Commercial Chan * * * *
SiemonUltra 6 UTP/STP Chan * * * * * * * * * * * * *
MISC. TYPES
LOCAL TALK * * * * *
ISDN * * * * * * *
DIN 44312-1 * * * * * * * * * *
Bavaria STP Link * * * * * * * * * *
AUTOMATCH * * * * * * * * *
ECOMATCH * * * * * * * * *
FOILTEK * * * * * * * * * *
PAIRTEK * * * * * * * * * *
SINGLE PAIR * * * * *
USOC * * * * * * *
IBM COAX * * *
TWINAXIAL * * *
ARCNET * * *
CATV * * *
VW STP Link * * * * * * * * * *
Cat 6-200 UTP/STP Chan * * * * * * * * * * * * *
Cat 6-200 UTP/STP Link * * * * * * * * * * * * *
ALLIANZ 900 Chan * * * * * * * * * * * *
Korean Emblem Grade 3 Chan * * * *
Korean Emblem Grade 2 Chan * * * * * * * * * * *
Korean Emblem Grade 1 Chan * * * * * * * * * * *
Korean Emblem Premier Chan * * * * * * * * * * *
TPPMD UTP Chan * * * * * * *
TPDDI STP Chan * * * * * * * * * *  
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MISC. TYPES
RG59 100ft/31m MAX * * * * *
RG59 Tri-Shield 100ft/31m MAX * * * * *
RG59 Quad-Shield 100ft/31m MAX * * * * *
RG59 300ft/92m MAX * * * * *
RG59 Tri-Shield 300ft/92m MAX * * * * *
RG59 Quad-Shield 300ft/92m MAX * * * * *
RG6 100ft/31m MAX * * * * *
RG6 Tri-Shield 100ft/31m MAX * * * * *
RG6 Quad-Shield 100ft/31m MAX * * * * *
RG6 300ft/92m MAX * * * * *
RG6 Tri-Shield 300ft/92m MAX * * * * *
RG6 Quad-Shield 300ft/92m MAX * * * * *
TIA 568-B.2 UTP/STP Patchcord * * * *
CAT6 Patchcord Quality Test * * * *
TERA Patchcord Quality Test
CAT5E Patchord Quality Test * * * *
ISO F 1000 Draft STP Chan * * * * * * * * * * * *
ISO F 1000 Draft STP Perm * * * * * * * * * * * *
ETHERNET
10Base T * * * * * * *
10Base 2 * * *
10Base 5 * * *
100Base T Basic * * * *
100Base T Channel * * * *
Cat6 10GbE TSB155D 3.0 UTP/STP Chan * * * * * * * * * * * * *
Cat 6a 10GbE Draft 3.0 UTP/STP Chan * * * * * * * * * * * * *
ISO E 10GbE Draft 762 UTP/STP Chan * * * * * * * * * * * *  

Note: ISO F 600 is available only on the LANTEK 7/7G.  

TEST SETUP 

1. If the LANTEK tester has not been calibrated in the past 7 days, it is recommended 
that you perform a field calibration. 

2. Configure the tester as required. See Setting Preferences. 

3. Select the Cable Type. 

4. Disconnect the cable to be tested from all network equipment. 

5. Connect the Adapters to both handsets. 

6. With the appropriate patchcords, connect the Display Handset patchcord to one 
end of the link and the Remote Handset patchcord to the opposite end. 

7. Press ON/OFF key to power up the Display Handset. 
Note: The Remote Handset will be powered up automatically by the Display Handset 
when the AUTOTEST begins. LANTEK Channel Adapters and patchcords are used for 
both Permanent Link and Channel Link testing. The LANTEK unit will set the 
Reference Plane and Test Limits according to the type of test selected. For Fiber 
testing, the RH must be powered on manually. 
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TEST SEQUENCE 

When the AUTOTEST button is pressed, the following actions occur: 

1. The DH firsts attempt to communicate with the RH (Remote Handset) using one 
correctly wired pair. If it is unable to establish communication, the DH will display 
a message that it is looking for the RH and continue trying until the Autotest is 
manually canceled or the RH is found. 

2. Once communication with the RH is established, its serial number is checked to see 
if current field calibration data exists. If a field calibration has not been performed 
in the last 7 days with the RH unit, the Autotest will be aborted and a “Calibration 
Required” message will display. 

3. If the serial number is valid, the DH will proceed with the specified Autotest. The 
first test performed in most Autotests is the Wire Map for twisted pair cable types. 

4. After running the Wire Map test, Autotest runs the remaining tests specified for the 
currently selected cable type. You have the option of specifying (in Autotest 
Preferences) that testing halt after any failed test or proceed through the entire 
Autotest series regardless of test failures. 

5. Once an Autotest has been completed, all of the test data can be reviewed, saved, 
and printed. 
 The test results for the last Autotest are held in non-volatile memory and 
available for review or storage, even after power is cycled off and back on. 

 The last Autotest results remain in non-volatile memory until they are either 
replaced by new test results, the memory is cleared, or any Analyze test is 
performed. 

SETTING AUTOTEST PREFERENCES 

1. Select the Preferences on the Ready screen. The Preferences screen appears. 

2. Select Autotest Preferences. The Autotest Preference screen appears. 

3. Press the ARROW keys to highlight the desired option. 

4. Press  to activate or deactivate an option. 

5. Press ENTER to accept the selected Autotest Preferences or press ESCAPE to exit 
this screen without making changes. 

RUNNING AUTOTEST AND UNDERSTANDING RESULTS 

Autotest performs comprehensive tests using programmed testing limits. An overall 
pass or fail is displayed along with individual test results.  

Before beginning Autotesting, connect the Display and Remote handsets to the cable 
or link to be tested. 

1. Press AUTOTEST. During the Autotest, the handset unit will display a progress 
screen. 

2. If the RH unit is not found, a “Searching for Remote Handset” warning message is 
displayed on the DH. Press ESCAPE to cancel the test and return to the Ready 
screen. 

3. If the RH is found, Autotest compares the cable test readings to standards for the 
cable type selected and issues pass/fail statements for each test. 

4. When the Autotest is completed, an overall result of pass or fail is displayed at the 
top right of the test information columns. Results for individual tests are displayed 
opposite each test name. 
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5. To begin another Autotest, press AUTOTEST. If results from the current test have 
not been saved, you will be prompted to discard or save the current test results 
before the next Autotest will run.  
Note: The tester also performs real time Analyze testing that enables you to 
troubleshoot problem areas. If Autotest results indicate a failure, refer to the Analyze 
Testing section for further details. 

INTERPRETING AUTOTEST RESULTS 

Pass/Fail Reporting 

The overall Autotest result is displayed at the top right of the Autotest display screen. 
Individual Autotest results are displayed to the right of each test. 

 

Figure 3-2: Typical Overall Autotest Results Screen 

 
Table 3-2: Test Result Symbols 

Symbol Overall Autotest Result 

 
Overall test result is a pass if each individual test is a pass or a pass*. 

 
Overall test result is a fail if one or more individual test is either a fail or a fail*. 

 

Viewing Current Autotest Results 

Results can be viewed at completion of the test sequence or saved for later viewing. 

1. Press the ARROW keys to highlight the desired test. 

2. Press ENTER to view test results. 

 

Figure 3-3: Typical Individual Autotest Results Screen 
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3. When finished, press ESCAPE to return to the Autotest screen. 

Understanding Test Failures 

A failure result for Autotest indicates that one or more tests did not meet minimum 
cable parameter levels for the cable type selected. 

Note: Be sure that you have selected the correct cable type and are using appropriate 
connectors and links. 

Identifying which tests failed and the characteristics of the failure will determine the 
type of fault. If the Autotest shows a failure on a particular sub-test, perform Analyze 
testing for the failing test in order to troubleshoot the cable. 

When more than one test fails on Autotest, the test order used for troubleshooting is 
an important element in eliminating the source of the problem.  

If any tests fail, Analyze tests should be performed in the following order: 

1. Wire Map  

2. DC Resistance  

3. Length 

4. Delay and Skew 

5. Impedance  

6. Attenuation  

7. NEXT  

8. Dual Return Loss  

Refer to the Analyze Testing section to run these tests. 

WARNING SCREENS  

In response to a change in parameter(s), failure, harmful condition, or operational 
limitation, the tester will display a warning screen advising you of the activity or 
request you are engaged in. The screen will prompt you to YES (continue) or NO 
(exit).  

 

Figure 3-4: Sample Warning Screen 
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USING JOBS TO STORE TEST RESULTS  

The LANTEK tester can store cable test results under separate Job names. You can 
create Jobs, assign any name to them, and store test results on a Job-by-Job basis. 
By using Jobs, you can logically group and store test results in a descriptive manner 

You can set up a separate Job for each floor in a building, each building on a campus, 
each customer, or for any other user-defined classification. 

To create a New Job:  

1. Select Stored Results on the Ready screen. Press ENTER. At this point, you will 
see a list of all the jobs which are currently available. If you have never created a 
Job, the list will be empty. 

2. To create a new Job select . The Job Options screen appears. 

3. Press the ARROW keys to select New Job. Press ENTER. The New Job screen 
appears. 

4. Type a name into the text field on the New Job screen using the alphanumeric 
keyboard. Press a key a second or third time to select the second or third 
character on the key. Press the RIGHT ARROW key or wait a few seconds to 
advance to the next character position. 

5. After entering the name, press ENTER, returning to the Job Options screen where 
you can Access Job information, Delete Jobs, Rename Jobs, make a Job the current 
Job, or create more Jobs. The new active job name is displayed at the top left 
corner of the display. 

SAVING CURRENT AUTOTEST RESULTS 

The maximum individual Autotest results of 500 TIA CAT 6 with graphs or 30,000 plus 
without graphs can be stored in the LANTEK internal tester memory and accessed 
later using the Test Results menu. Autotest results can be saved immediately following 
the test. 

 Only overall passed Autotests can be automatically saved. 

 The entire set of test results is saved as one file. 

 Test results are automatically saved if the AutoSave preference is enabled. Refer 
to Setting Preferences. 

 Test names are automatically assigned to completed tests. If a different name is 
desired, a test can be named manually using the ‘Rename’ selection.  

To manually save Autotest results (AutoSave Disabled): 

1. Press SAVE. The Test Saved screen will be displayed for a brief period, showing 
the name the test is saved under. 

2. If the current name already exists, a warning screen appears asking you to 
overwrite the currently existing file or rename the results to another file or new file 
name. 

3. Press NO to exit and return to the previous screen without performing a save 
operation. Press YES to overwrite the existing file. 

4. Select  to rename the current test. The Save Test screen will appear with a 
new name option.  

5. Press ENTER to accept the change and return to the Test Results screen. 
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VIEWING OR DELETING STORED AUTOTEST RESULTS 

You can view, print, delete or rename the Stored Results files. 

When an Autotest or TDR is saved, the data is stored with a unique name. Test results 
can be viewed, printed, or deleted from the Stored Results screen. 

1. Select Stored Results on the Ready screen to open the Job List screen. 

2. Highlight the desired Job. 

3. Select  to choose the desired Job. 

4. Select  to open the Options screen. 

5. Press the ARROW keys to highlight the desired selection. 

6. Press ENTER to perform the desired option. 

7. Press ESCAPE at any time to return to the previous screen. 
 

Job and Test Options 

 

Figure 3-5: Job Options Screen 

 
Table 3-3: Job Options 

Option Description 

Current Job Info Total number of tests passed/failed, cable length, and memory used 
for current job. 

All Job Info Total number of tests passed/failed, cable length, and memory used 
for all jobs. 

Delete Selected Jobs Selected jobs are deleted and sent to the internal wastebasket. 

Rename Job Change name of currently highlighted job. 

New Job Add new job to the job list. 

Make Job Current Activate the highlighted job.  Saved tests (Autotests) will be stored 
in this job. 

Restore All Deleted 
Jobs 

Restore all deleted jobs currently in the internal wastebasket. 

Copy Selected Jobs to 
Compact Flash 

Copy all tests of the selected job from internal memory to Compact 
Flash. 
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Figure 3-6: Test Options Screen 

 
Table 3-4: Test Options 

Option Description 

Select All Select all stored test results. 

Select All Passed Select only passed tests for processing. 

Select All Failed Select only failed tests for processing. 

De-select All Unmark all stored test results. 

Print Selected Print selected test results. 

Print All Print a summary of stored test results. 

Restore All Deleted Tests Restore all deleted test. 

Delete Selected Test Delete marked test results. 

Delete All Delete all stored test results. 

Result Info Display test result information such as number of tests, number 
passed and failed, length tested, and memory used. 

Selected Result Info Display the results of selected tests. 

Rename Test Rename selected test result. 
 

AUTOTEST GRAPHS 

Autotest results can be viewed at the completion of the test sequence in either a 
tabular or graphical format. 

Graphing Facts 

Graphs can be very useful for viewing test results. There are a few things you need to 
know before you start using them: 

 In Autotest Preferences, you can set your tester to include and save graphs with 
test results.  

 The limit and worst case margin parameters are displayed at the bottom of the 
tabular test screen. 

 When you go to graph view, the vertical cursor is placed at the worst case 
margin location. 
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To view an Autotest graph: 

1. Configure the Autotest Preferences. 

2. In Autotest Preferences, make sure the Save Graphs checkbox is selected. 

3. Press AUTOTEST. Upon completion of the test suite for the cable type selected, 
the Overall Autotest results screen displays. 

4. To display tabular data, highlight the desired test result (the NEXT test) and press 
ENTER. 

5. To display a graph of the tabular data, highlight the tabular data of interest (pairs 
7, 8 and 3, 6) and press ENTER. 

6. The graph will always open with the cursor positioned on the worst case margin. In 
this example, the cursor is positioned on the horizontal axis at 215.00 MHz. 

7. Press ESCAPE to return to the previous screen. 

 

Figure 3-7: Typical Autotest Graphic Display 

 

Graph Formats, Layouts, and Controls 

Graphs are useful for observing the relationship between two network cable 
parameters, actual measured parameters and predefined worst case margins.  

There are two different graph formats: single and dual plot.  

Single Plot  Dual Plot 

 

  
   

Figure 3-8: Single and Dual Plot Graphic Display 
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Layout and Controls 

The horizontal axis represents frequency data and the vertical axis represents the 
measured values in dB, with limits indicated as a solid line trace. 

Tabular View Graphic View 

 

Figure 3-9: Autotest Tabular Data and Graphic View Layout 

Note: The margin data at the bottom right of the Tabular screen represents the worst 
case difference between the actual measured data and the predefined limit threshold 
as shown by the cursor position in the graph on the right. 

Table 3-5: Autotest Graph View Layout and Controls 

Item Function 

1 Wire pair plotted from tabular data. 

2 The horizontal axis represents frequency data. 

3 The vertical axis represents measurements in dB. 

4 When a wire pair graph is first displayed, the cursor is automatically positioned at 
the worst case limit and frequency point. 

5 Actual data plot for a wire pair. Attenuation is plotted in this example. 

6 Predefined worst case limit plot for attenuation. 

7 Predefined worst case limit plot for NEXT. 

8 Actual data plot for a wire pair. NEXT is plotted in this example. 

9 Expands or compresses the horizontal axis of the graph. At full magnification, these 
keys become inactive. 

10 Arrow keys are used to move the cursor horizontally. As the cursor moves, screen 
readouts will change to reflect cursor position. 

- Use the soft keys to move the cursor in large steps. 
- Use the key pad keys to move the cursor in small steps. 
- Hold the SHIFT key while using the ARROW keys to make large cursor steps. 
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ANALYZE TESTING FOR STRUCTURED CABLE 

ANALYZE SINGLE TEST MODE OVERVIEW 

Analyze mode allows you to troubleshoot by running individual tests, making 
adjustments, and observing changed test results. For example, a failed capacitance 
measurement can indicate crimped or stretched cable. With Analyze testing, you can 
walk the cable and check for damage and stretching. Freeing the cable at suspected 
problem areas should improve the measured reading. 

Depending on the cable type and defined test standard, any or all of the following 
individual tests are available:  

Wire Map Resistance Length 

Capacitance NEXT Attenuation/Insertion Loss 

ACR Return Loss Impedance 

Delay and Skew Power Sum NEXT Power Sum ACR 

Headroom ELFEXT Power Sum ELFEXT 

TDR   

Note: The RH is required to perform all tests with the exception of: TDR, Resistance, 
Length, Capacitance, Impedance, and Delay & Skew. 

Wire Map Test  

Wire Map testing is used to locate shorts, opens, and miswires. Test results are 
displayed graphically for easy visual indication of any problems.  

 

Figure 3-10: Wire Map Test Screen 

Wire Map Errors  

A failure in a Wire Map should always be the first problem corrected, since it causes 
faults in other tests. One open pin can cause DC loop resistance and attenuation tests 
to fail. An open may also cause a zero capacitance reading, and will cause false 
readings in NEXT tests. 

A wire map test will always look for and map all nine possible wires (four pairs + 
shield) but will only consider wires defined as present in the selected cable type for 
pass/fail criteria. For example, a wire that is not specified in the cable type will show 
on the map but will not cause a test failure. 
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The Wire Map test guarantees the following minimum level of error detection (based 
on four pairs of conductors, shield optional): 

 Any wiring error or combination of wiring errors will indicate a wire map failure. 

 Any combination of up to three opens, shorts, or cross-connections will be 
correctly identified. 

 Opens and shorts will provide an indication of the cable end that the error 
occurred on (provided by Length screen results in Autotest). 

 Split pairs will be identified based on specific patterns of inconsistent NEXT 
(Near-End Crosstalk). 

Troubleshooting Wire Map Problems  

Problem: One or more open pins 

Probable Causes Connector-to-wire punch down not mated 
Defective jack or plug. 
Broken wire(s). 

Other Tests Affected Test   Possible Result 
DC Resistance  Fail. 
Attenuation  Fail. 
NEXT   Some false measurements. 
Mutual Capacitance 0 reading possible. 
Length   May be low if the open is near the DH. 

 
Problem: Shorted pins 

Probable Causes Conductors making contact at a connector. 
Jack or plug has pin or circuit defect. 
Cable damaged. 

Other Tests Affected Test   Possible Result 
DC Resistance  Low or zero. 
Attenuation  Fail. 
NEXT   Some false measurements. 
Capacitance  Over limit. 
Length   Reduced or shorted pairs. 

 
Problem: Miswired pins 

Probable Causes Conductors reversed at a connector. 

Other Tests Affected Test   Possible Result 
Usually none  Infrequently, one or more tests may fail. 
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Wire Length Test  

This test measures the length of each wire pair to make sure that the recommended 
limits for the particular cable type are not exceeded. The Wire Length Test is mainly 
used for informational purpose only. Depending on the units selected in the Setup 
menu, length is reported in either feet or meters.  

 

Figure 3-11: Wire Length Test Screen 

Length and NVP 

Measuring the length of the cable requires that you know the Nominal Velocity of 
Propagation (NVP) of the cable. Refer to the specification or the manufacturer of the 
cable you are testing for the cable NVP. If the wire specification is not available, use a 
known length of good cable (100 - 200 feet) and use the calculate NVP function to 
enter the total length of the cable and calculate the correct NVP.  

Wire Length Errors  

Lengths may differ slightly between pairs in the same cable, due to minor NVP 
differences between the pairs and physical length differences due to twisting patterns. 
When electrically measured cable length varies too much from actual length, a 
problem exists. 

Troubleshooting Wire Length Problems  

Problem: Length between a pair of the same cables varies by more than 10%. 

Probable Causes Incorrect NVP. 
Excessive cable length. 
Installed matched terminator not functioning correctly. 
Cable insulation damage to longer pairs. 
Break or short in a pair. 
Elevated capacitance on a pair. 

Other Tests Affected Test   Possible Result 
DC Loop Resistance May be slightly high or fail. 
Attenuation  May be slightly high or fail. 
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Resistance Test 

This test measures the loop resistance of each pair of wires. The test is performed to 
ensure total loop resistance does not exceed recommended limits. Results are 
displayed with resistance in ohms for each pair and a comparison limit for the cable 
type.  

 

Figure 3-12: Resistance Test Screen 

Resistance Errors 

All four pairs of a network link should have approximately the same resistance. Pair 
resistance that exceeds the limit is indicated as a failure. The maximum limits in the 
default tables are based on the maximum length limit of the link or cable segment. 

Troubleshooting Resistance Problems 

Problem: Excessive Resistance 

Probable Causes Mismatched cable types. 
Poor punch block connection. 
Poor RJ-45 termination connections. 
Wire pair has a tap (never done). 
Cable damage. 
Shorted cable. 

Other Tests Affected Test   Possible Result 
Wire Map  May fail. 
Attenuation  May fail. 
NEXT   May have false readings. 
Capacitance   May fail. 

Problem: One wire pair has a very high DC loop resistance, others are normal. 

Probable Causes Poor connection points. 
Cable damage. 
Connector blades not fully piercing wire insulation.  
Worn Connector 

Other Tests Affected Test   Possible Result 
Wire Map  May fail. 
Attenuation  May fail. 
NEXT   May have false readings. 
Capacitance  May fail. 
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NEXT, ELFEXT, and Power Sum Tests  

The NEXT (Near End Crosstalk) and ELFEXT (Equal Level Far-End Crosstalk) tests 
measure crosstalk at the near and far ends of the cable in one Autotest. High levels of 
crosstalk can cause excessive retransmissions, data corruption, and other problems 
that slow the network system. 

  

Figure 3-13: NEXT and ELFEXT Test Screens 

NEXT, FEXT, and ELFEXT 

The NEXT test measures cross-talk from a transmitting pair to an adjacent pair in the 
same cable sheath. NEXT is measured at the DH and RH. 
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Effect of
Adjacent Pair  

 The FEXT test is similar to the NEXT test except that the traffic is generated at 
the RH and crosstalk is measured at the DH. 

 NEXT measurements are made at each end of the cable for all pair combinations 
(pair 1-2 vs. 3-6, etc.), yielding a total of twelve measurements. 

 ELFEXT measurements are made with the DH and RH for all possible pair 
combinations (1-2 vs. 3-6, 3-6 vs. 1-2, 1-2 etc.) at both ends yielding a total of 
twenty-four measurements. 
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Power Sum NEXT and Power Sum ELFEXT 

Power Sum tests measure the crosstalk effects of three transmitting pairs on the 
fourth pair in the same cable sheath. 
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Effects of
3 Pairs on 1 Pair  

During the Power Sum NEXT test, six measurements are made at each end of the 
cable and combined (pairs 1-2, 3-6, and 4-5 vs. pair 7-8, etc.) for a total of eight 
measurements.  

 

Figure 3-14: Power Sum NEXT Test Screen 

During the Power Sum ELFEXT test, twelve measurements are made at the DH side of 
the cable and combined (pairs 1-2, 3-6, 4-5 vs. pair 7-8, etc.) for a total of four 
measurements. 

 

Figure 3-15: Power Sum ELFEXT Test Screen 

Note: Power Sum NEXT measurements will generally read 2 - 3 dB lower in value 
(higher crosstalk) than conventional NEXT. 
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NEXT and ELFEXT Errors 

Crosstalk is usually caused by poor connector termination on the ends of the cable. A 
low value of dB measurement reading indicates presence of high crosstalk. 

Troubleshooting NEXT and ELFEXT Problems 

Problem: Low dB test readings 

Probable Causes Installed cable or patch cable not correctly rated. 
Defective, poor quality cable or too many connectors. 
Poor quality installation at the connection points. 
Too much insulation has been stripped from the wires at 
termination. 
A pair of wires has been untwisted too much at termination. 
Split-pairs. 
Poor quality connectors or connectors not rated to desired 
category. 
Delay skew (ELFEXT). 
Excessive noise entering the cabling system from external sources. 

Other Tests Affected Test   Possible Result 
Return Loss   May be over limit. 
NEXT    May show same symptoms. 

 

Attenuation Test 

This test measures the overall signal strength loss in the cable and verifies that it is 
within acceptable limits. Low attenuation is essential for error-free transmission. 
Attenuation is measured by injecting a signal of known amplitude at the Remote 
Handset and reading the amplitude at the Display Handset.  

 

Figure 3-16: Attenuation Test Screen 

Attenuation Errors 

Attenuation causes a loss of signal strength over a cable. The loss increases with cable 
length, signal frequency, and temperature. Attenuation testing can be used to find 
problems in the cable, connectors, or connecting hardware. A high value of dB test 
reading indicates a high value of attenuation, leading to greater loss of signal. 
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Troubleshooting Attenuation Problems 

Problem: High Attenuation Reading 

Probable Causes Poor connector termination points. 
Excessive cable length. 
Incorrect or poor quality adapter cable. 
Incorrect cable. 

Other Tests Affected Test   Possible Result 
DC Loop Resistance May be high. 
Capacitance   May be high. 
Length   May be over limit. 
NEXT    May be low on pair combinations. 
Average Impedance May be low. 
Return Loss  May be over limit. 

 

Return Loss Test 

This test measures the ratio of reflected to transmitted signal strength. Good quality 
cable runs will have little reflected signal, indicating good impedance matches in the 
run’s various components. 

 

Figure 3-17: Return Loss Test Screen 

Return Loss Errors 

Like attenuation, excessive return loss reduces signal strength at the receive end. It 
also indicates a mismatched impedance at some point along the cable run. A value of 
20 dB or greater indicates a good twisted pair cable. A value of 10 dB or less is 
severe, and causes a large reflection of signal back to the source. 
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Troubleshooting Return Loss Problems 

Problem: Excessive Return Loss (Value of 10 dB or less) 

Probable Causes Open, shorted, or damaged cable. 
Installed cable, cable segments, or patch cord have improper 
characteristics. 
Damaged or worn cable or connectors. 
Poor punch-down. 
Factory splice in cable. 

Other Tests Affected Test   Possible Result 
Attenuation  May be high. 
Capacitance and  Could be affected if the impedance 
Average Impedance  mismatch is caused by cable damage. 
DC Loop Resistance May be high if due to a poor punch-down. 

 

Impedance Test 

Average impedance is derived from electrical delay and capacitance measurements. 
The results of this test are expressed in ohms. Average impedance testing can help 
identify physical damage to the cable, connector defects, or cable segments with 
incorrect characteristic impedance. 

This test uses capacitive measurements; therefore, it is necessary to specify the 
correct cable type in order to accurately perform the test. 

Note: If a CAT 3 cable is selected (specified as the cable type where PVC is used in 
the cable insulation) but a CAT 5 cable (where Teflon® is used as the cable insulation) 
is actually used, the average impedance will be calculated incorrectly. To avoid this 
problem, be sure to specify the correct cable type. 

 

Figure 3-18: Impedance Test Screen 

Impedance Errors 

Impedance errors cause signal reflection and strength reduction. Average impedance 
of each pair should be equal to the LAN system impedance of 100, 120, or 150 Ω. 
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Troubleshooting Impedance Problems 

Problem: High Impedance Readings 

Probable Causes Compression, stretching, or excessive bending damage to the 
cable.  
Defective connectors.  
Insulation damage at a connector. 
Ground loops created between cable shielding (if used) and 
equipment grounding (via RS-232 cable to computer, or auxiliary 
power). 
Improperly chosen cables or patch cords. 
Moisture in the cable. 

Other Tests Affected Test   Possible Result 
Length   Affected pairs will appear longer. 
Average Impedance Change in average impedance is inversely 
   proportional to change in capacitance. 

 

Delay and Skew Test  

This test measures the period of time for a test signal applied to one end of a cable 
run to reach the other end. Skew indicates the difference between the measured time 
delay for that pair and the pair with the lowest value (displayed as 0.0 ns). Delay and 
Skew limits are set according to the currently selected cable type. 

 

Figure 3-19: Delay and Skew Test Screen 

Delay and Skew Errors 

Delay and skew measurements will usually differ slightly between pairs in the same 
cable. A substantial difference indicates a cable installation problem or a pair defect. 

Troubleshooting Delay and Skew Problems 

Problem: Excessive Differences between Measurements 

Probable Causes Cables which use different materials for insulating the four pairs of 
wires. 
A break or short in the pair. 
Excessive cable length. 
Cable installation problems. 

Other Tests Affected Not Applicable 
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Capacitance Test 

This test measures the mutual capacitance between the two conductors of each wire 
pair to verify that installation has not affected the capacitance for the particular cable 
type.  

 Bulk capacitance measurements are displayed in nanofarad (nF) in the Analyze 
Capacitance test.  

 Autotest measures the bulk capacitance in picofarads (pF) per foot or meter. 

 

Figure 3-20: Capacitance Test Screen 

Capacitance Errors 

The larger the capacitance; the higher the error rate. Small changes in the 
capacitance measurements are normal due to the handling of the cable during 
shipping and installation. The addition of connectors and patch cables will also affect 
capacitance values. 

Troubleshooting Capacitance Problems 

Problem: Capacitance Exceeds the Maximum Limit 

Probable Causes Compression, stretching, or excessive bending damage to the 
cable.  
Defective connectors.  
Insulation damage at a connector. 
Ground loops created between cable shielding (if used) and 
equipment grounding (via RS-232 cable to computer, or auxiliary 
power). 
Improperly chosen cables or patch cords. 
Moisture in the cable. 
Poor connections at punch downs and wall plates 

Other Tests Affected Test   Possible Result 
Length   Affected pairs will appear longer. 
Average Impedance Change in average impedance is inversely  
   proportional to change in capacitance. 
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ACR and Power Sum ACR Test  

The ACR (Attenuation-to-Crosstalk Ratio) test performs a mathematical comparison 
(difference calculation) between the results of the Attenuation and NEXT tests. The 
difference reading between each pair gives an indication of how problem-free the 
cable pair will be for transmissions.  

The ACR measurements are calculated pair-to-pair. The Power Sum ACR 
measurements are calculated by summing the NEXT between a selected pair and the 
other three pairs in the same cable sheath. 

  

Figure 3-21: ACR and Power Sum Test Screens 

ACR and Power Sum ACR Errors 

A large difference reading is desirable, since it indicates a strong signal and little noise 
interference. 

Troubleshooting ACR and Power Sum ACR Problems 

Refer to the NEXT and Attenuation troubleshooting suggestions. 
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Headroom Test 

The Headroom measurement is a mathematical analysis of the data already existing 
from previous tests.  The calculated value is the sum of the Power Sum ACR test 
(Power Sum ACR of the worst pair after the attenuation for that pair has been 
normalized to 100 meters or 328 feet) and the additional margin between the worst 
case PS NEXT and the limit for PS NEXT. 

Headroom provides a simplified means of reporting the margin available in a single 
cable run which will support an application with error-free performance. It also gives 
an indication of additional margin which may be achieved through the utilization of 
“enhanced” cable and connectors and careful installation practices. 

 

Figure 3-22: Headroom Test Screen 

 

Headroom Errors 

The Headroom number, reported in dB, characterizes the worst-case margin found in 
a single cable run.  A large number is desirable, since it indicates a strong signal and 
little noise interference. The pass/fail limit for Headroom is the same as Power Sum 
ACR. 

ANALYZE TEST SETUP 

1. If the LANTEK tester has not been calibrated in the past 7 days, perform a field 
calibration. 

2. Configure the tester as required. 

3. Select the Cable Type. 

4. Disconnect the cable to be tested from all network equipment. 

5. Connect adapters and patchcords to both the Display and Remote Handsets using 
the connectors. 

6. Connect the Display Handset patchcord to one end of the link and the Remote 
Handset patchcord to the opposite end.  
Note: Refer to Permanent and Channel Link testing for details regarding typical 
connections. 

7. Press ON/OFF to power up the Display Handset. 
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ANALYZE TEST SEQUENCE  

When an individual test is running, the following actions occur: 

1. If the test requires the RH (Remote Handset), the DH will first attempt to 
communicate with the RH. If it is unable to establish communication, the DH will 
display a message that it is looking for the RH and continue trying until the 
Analyze test is manually canceled or the RH is found. 

2. Once communication with the RH is established, its serial number is verified to the 
current field calibration data. If a field calibration has not been performed in the 
last 7 days with this RH, an appropriate “Calibration Recommended” message will 
display. 

3. If the serial number is valid, the DH will proceed with the specified individual test. 

4. If the test does not require the RH, the DH will run the test and display test data. 
Note: Pressing the ESCAPE key will cause the display to STOP scanning for the 
Remote and initiate the test in situations where the Remote is not required. 

5. Once a test is completed, the test data can be reviewed or printed. 
 

RUNNING A SINGLE TEST 

Before beginning Analyze testing, connect the Display and Remote Handsets to the 
cable or link to be tested. 

All Analyze tests are performed using the following procedure: 

1. Select Analyze on the Ready screen to open the Analyze screen. The Analyze 
screen lists the tests that can be performed on the currently selected cable type. 

2. Press the ARROW keys to highlight the desired test. Below is an example of the 
Length test. 

 

 

Figure 3-23: Analyze Screen 

3. Press ENTER to start the test. During the execution of the test, the handset unit 
will display a progress screen. 

4. Upon test completion, the tabular results screen is displayed. 
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INTERPRETING ANALYZE TEST RESULTS  

Pass/Fail Reporting  

The overall Analyze test result is displayed below the Title Bar at the top right of the 
display screen. Individual wire pair test results are displayed to the right of each test. 

 

Figure 3-24: Test Results Screen 

In the example above, the DC Resistance test results screen is displayed. 

 An overall test result of pass or fail is displayed at the top right, below the date. 

 Individual wire pair test results are displayed in the last column on the right 
(Result column). 

Overall and Individual test result reporting is similar to the Autotest function.  

Printing Analyze Test Results 

A tabular test result screen can be sent directly to a serial printer. Before sending a 
result screen to the printer, the printer port needs to be configured.  

Analyze Graphs 

Certain Analyze test results can be viewed at the completion of the test sequence in 
either a tabular or a graphical format. Analyze graphs are similar to the Autotest 
graphs. 

1. Run an Analyze test. 

2. Position the highlighted cursor on the desired table data. 

3. Press ENTER to display the wire pair table data as a graph. 
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TROUBLESHOOTING TOOLS: TDR 

Time Domain Reflectometer is one of the most powerful diagnostic tools available for 
metallic cable troubleshooting. While conventional test methods cannot locate the 
fault, TDR is used to reveal conditions about a cable that simple Pass/Fail reports and 
raw measurements may not show.  

The LANTEK tester uses the TDR test to scan the length of a cable for impedance 
problems, or to accurately verify the cable length. TDR is not limited to identifying just 
shorts or opens; it also points out any disturbances in the cable. 

HOW TDR WORKS 

The TDR function transmits energy into a cable pair, and the returning reflections are 
monitored in a manner similar to radar. 

 The shape of the reflection identifies a cable deformity, open, short, or 
termination. 

 The length of time it takes a transmitted pulse to return is used to calculate 
cable length. 

HOW TO PERFORM A TDR TEST 

Prior to running the TDR, connect the LANTEK DH to the cable or link to be tested. The 
TDR function is not a selected test available through custom cable setting. 

TDR Test Setup 

1. Select the Cable Type. 
Note: All TDR numerical information is NVP details of custom cables can be derived 
from the data in the cable database. 

2. Calibrate and configure the tester as required. 

3. Disconnect the cable to be tested from all network equipment. 

4. Connect the required test lead to the Display Handset and to one end of the link 
(TDR does not require a Remote Handset). Refer to Overview of Link Testing and 
Requirements. 

5. Press ON/OFF to power up the Display Handset. 

Performing a TDR Analyze Function 

1. Select the Analyze on the Ready screen. The Analyze screen appears. 

2. Press the ARROW keys to highlight the TDR function. 

3. Press ENTER to start the TDR test. 
Note: When TDR is running, relays will be heard clicking in the Display Handset. 

4. At the completion of the TDR test, a graph is displayed. 
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THE TDR PLOT 

The TDR graph is an image of the structure of the cable under test along its entire 
length, up to a limit of 2000 feet (609.6 meters). This graph shows anomalies by 
displaying blips, peaks, or valleys on an otherwise flat line. 

TDR Plot Layout and Controls 

The horizontal axis represents distance data and the vertical axis represents the 
percentage of reflection. 

 

Figure 3-25: TDR Graphical Plot Layout and Controls 

 

Table 3-6: TDR Graphical Plot Layout and Controls 

Item Function 

1 Actual TDR data plot for a wire pair. When a wire graph is first displayed, the 
cursor is automatically positioned at the midpoint of the data. 

2 Designated wire pair plotted from TDR data. (Pair A, B, C, or D) 

3 Distance in meters or feet and impedance value at the cursor. 

4 The vertical axis represents percentage of reflection data. 

5 The horizontal axis represents distance data. 

6 Left side of the display shows total length in meters or feet. 
Right side of the display shows the minimum/maximum level of Distance of 
cursor vs. total length measured in points and associated measured levels of 
impedance. 

7 Zoom out/Zoom in keys to expand or compress the horizontal axis of the graph 
at the cursor. 

8 Arrow keys are used to move the cursor horizontally. The screen data displayed 
will change to reflect the cursor position. 
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VIEWING TDR RESULTS  

When the TDR diagnostic function is first started, the graphical plot is automatically 
scaled to the full length of the cable. A maximum of 2000 feet (609.6 meters) of cable 
results can be displayed on a TDR graph. 

When TDR is first activated, the left 10% of the graph displays prelaunch impedance 
signal rise distance data and the right 10% of the graph displays reflection data. 

 Press the LEFT/RIGHT ARROW keys to move the cursor horizontally. As the 
cursor moves, screen data displays will change to reflect cursor position. 

 Press the UP/DOWN ARROW keys to view TDR results from a different wire 
pair. The TDR test runs one time and displays the results. 

 Press the ZOOM keys to scale the graph. At the maximum or minimum limits 
the key becomes inactive. 

 TDR results can be uploaded and saved to a PC and printed. 
 

INTERPRETING TDR RESULTS  

Always note the cable pair currently being displayed. The shape of the reflections 
plotted for the pair can be used to identify and locate problems. If the cable pair has 
no problems along the entire length of the pair, the graph will appear as follows: 

 The graph has an upswing point on the left most 10% of the display (start of the 
cable). 

 The following 80% of the graph is relatively flat. 

 The graph has an upswing or downswing point on the right most 10% of the 
graph (end of the cable). 

At the end of the cable (right-side), a slope to the top means the pair is open, while a 
slope to the bottom of the screen indicates that the pair is shorted. 

EVALUATING A TDR GRAPH  

When evaluating the TDR graph, the first consideration should be the average 
impedance of the cable being tested:  

 A graph with sharp dips or spikes can identify anomalies.  

 For subtle problems, interpretations should be based on benchmark data 
obtained from the analysis of many cable segments.  

When anomalies are detected in the cable pair, the cursor is automatically placed on 
the first anomaly. Press the ARROW keys to highlight the anomaly of interest. 
Impedance and distance values will be displayed on the screen. 
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The following troubleshooting tips identify typical cable conditions and their 
corresponding screen plots. 

Condition TDR Plot Indication 

Open, Near End Upswing develops early. In comparison to good cable pairs, 
this pair appears shorter in length. 

Short, Near End Downswing develops early. In comparison to good cable pairs, 
this pair appears shorter in length. 

Open, Far End Fully developed upswing at the Far End. 

Short, Far End Fully developed downswing at the Far End. 

Split Pair 20% to 30% rise in relative impedance at the split with a 
corresponding drop in impedance where the pair is 
reconnected. 

Cable segment with higher 
than nominal impedance 

Peak in the level area of the plot. 

Cable segment with lower 
than nominal impedance 

Dip in the level area of the plot. 

Level Plot, much higher 
than the known cable NVP 

Wrong cable type selected, or wrong cable type installed. 

No distinct upswing or 
downswing at the Far End 

Matched terminator attached to the cable. The pair appears to 
have a very long length. 

 

STORING, RETRIEVING, AND DELETING TDR RESULTS  

Storing a Graph 

The TDR results can be stored in the Current Job.  

1. Press the UP/DOWN ARROW keys to select the desired cable pair graph. 

2. Press SHIFT key to save/print. 

3. Select . The Save Test screen appears. Press SHIFT to bring up the “Save 
As” or “Rename” selection if the test has already been stored. 

4. The test name is automatically assigned. If a different name is desired, press 
DELETE to change the highlighted character(s). 

5. When you have entered the name, press ENTER to accept the changes and return 
to the ready screen. 

 

Retrieving or Deleting a Graph 

For detailed instructions regarding retrieving or deleting stored TDR results, refer to 
Viewing or Deleting Stored Autotest Results. 
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TROUBLESHOOTING 10/100/1000 BASE-T 

10/100/1000 BASE-T Ethernet systems use twisted pair cabling for transmission of 
network data frames. Both the cable and connecting hardware must meet minimum 
standards as specified in the IEEE 802.3 standard. The default settings for 10BASE-T 
network links in the LANTEK tester reflect these standards. 

10/100 BASE-T systems use the 1 and 2 pins for transmit and the 3 and 6 pins for 
receive, as shown in Figure 7-5. The instrument passes or fails the Wire Map based on 
this pin configuration. If your system does not use the IEEE 802.3 wiring standard, a 
custom adapter is required to align nonstandard transmit and receive pairs. 

1000 BASE-T systems use all four pairs in a full-duplex (bi-directional) configuration. 

 

Figure 3-26: 10BASE-T Connector 

 

 



 

CHAPTER 4 
COAX CABLE FIELD 

CALIBRATION AND TESTING 

 

UNDERSTANDING COAX CABLE 

Coax has many desirable characteristics.  It is highly resistant to EMI (Electrical 
Magnetic Interference) and can support high bandwidths.  Many customers prefer 
using coax cable for CATV as well as Data applications.   

A typical coax cable has the following components: 

 Center Conductor:  This conductor usually consists of a fairly heavy, solid yet 
flexible wire; stranded wires can also be used.  Solid conductors are preferred 
for permanent wiring, but stranded conductors make the cable more flexible and 
easier to connect to equipment. 

 Insulation Layer:  Also called a dielectric layer, this layer provides electrical 
insulation and keeps the inner and outer conductors in precise coaxial 
relationship. 

 Outer Conductor or Shield:  This layer shields the inner conductor from 
outside electrical interference.  The shield can consist of braided wires, metal 
foil, or a combination of both.  Because of this shield, coax is highly resistant to 
electrical magnetic interference (EMI). 

 Jacket or sheath:  A durable plastic or Teflon jacket coats the cable to prevent 
damage. 

Coax cable varies in impedance measurement (measured in unit of ohm), which is an 
indication of the cable’s resistance to current flow.  For example, a RG-59 and RG-6 
coax cable will have an expected Impedance of 75-ohm, while a RG-58 coax cable will 
have a 50-ohm Impedance. 

 

COAX STANDARDS 

LANTEK can support the following Coax Standards: 

CATV Standards Ethernet Standards Misc. Cable Types 

RG59 100 or 300 ft  
(Tri or Quad-Shield) 

10Base 2 IBM Coax 

RG6 100 or 300 ft   
(Tri or Quad-Shield) 

10Base 5 TWINAXIAL 

  ARCNET 
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With LANTEK, AUTOTEST is the easiest and quickest way to measure and verify your 
cable installation.  A variety of supported coaxial cable type can be found under “Cable 
Types”.  LANTEK can support coaxial cable testing to the standards identified below.  
Under each specific cable type, you will also find the specific test limits by executing 
the following steps: 

1. From the DH Ready Screen, press <SHIFT>F4 or select “Cable Type” 

2. Using the ARROW Keys, select “Ethernet”. 

3. Within the Ethernet Cable Type screen, highlight cable type “10Base 2”, then 
select the softkey CREATE. 

4. The Create Custom Cable screen appears, use the ARROW KEYS and highlight 
“Test Limits” and press ENTER to view the specific test limits for this cable.   

 

COAX AUTOTEST SUITE 
 

CABLE TYPES Resistance Length Attenuation Return Loss Impedance 

RG59 100 or 300 ft X X X X X 

RG6 100 or 300 ft X X X X X 

IBM Coax X X X   

TWINAXIAL, ARCNET X X X   

10BASE2  
(IEEE 802.3) 

X X X   

10BASE5  
(IEEE 802.3) 

X X X   

 

 

COAX FIELD CALIBRATION AND TESTING PROCEDURE 

Field Calibration using COAX adapters uses a modification of the LANTEK 4-step 
process.  Since COAX testing is done for low frequencies, the additional data obtained 
during the calibration process is essentially ignored, and therefore the LANTEK will 
request one calibration process step to be performed. 

To start testing COAX cable, refer to Setting Preferences and Autotest & Single Test 
for Structured Cable as indicated in previous Chapters for details.   

Please follow the procedures below to perform cable selection of COAX cables: 

Note:  The LANTEK COAX adapters are configured with BNC connectors. User 
supplied adapters will be necessary to convert to-from BNC to F (CATV) or other 
connector types. 

1. From the DH Ready Screen, press <SHIFT>F4 or highlight the Cable Type icon, 
press ENTER. 

2. Using the ARROW KEYS highlight “Misc. Types” and press ENTER. 

3. Highlight the desired Cable Test Standard, press ENTER.  The display will revert to 
the Ready Screen with the selected cable type updated. 
Note:  Other COAX Cable Types Available: RG59 & RG6 
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Figure 4-1: IBM COAX Cable Type Screen 

For COAX Field Calibration, please follow the instruction below: 

1. Connect the COAX adapters to the Display Handset (DH) and Remote Handset 
(RH).  

2. Insert the short COAX calibration cable into both the DH and RH adapters. 

3. From the DH Ready Screen, press F3 or highlight Field Calibration icon and press 
ENTER. 

4. Select START by pressing F1 to begin the calibration process.  Once the 
calibration process completion screen appears, select ESCAPE to return to the 
main screen.  

5. When the calibration process is completed, the LANTEK is ready for testing. 

 

Figure 4-2: IBM COAX Field Calibration Screen 
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TROUBLESHOOTING COAX CABLING 

Always use high quality connectors and tools to properly terminate COAX network.  In 
case of a cable fail, look for the following cases: 

 FAULTY TERMINATION - Make sure you have properly separated the center 
conductor from the shield. 

 CABLE SHORT - This could occur from improper termination both at near-end 
and far-end.  In case of a SHORT, look for the Resistance value on the tester.  A 
zero (0) – Ohm resistance value will suggest the fault is at the near-end of the 
cable, while a ~ 20 – Ohm value will suggest the fault is at the far-end. 

 CABLE OPEN - A common case.  To diagnose this situation, look at the cable 
length measurement.  A zero (0) cable length will suggest a fault at the near-
end. 

 USE of TDR to Diagnose Problem - The LANTEK build-in copper TDR is a good 
tool to identify the location of the fault and distance of the fault.  Refer to the 
TDR operation in this manual for more details. 
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SETTING AUTOTEST PREFERENCES 

Autotest is the most frequently used test mode. A number of preferences can be 
selected for the Autotest function: 

 Autosave 

 Pass Fail  

 Disable Fiber Autotest Length 
 

1. From the Display Handset Tools screen, select the Preferences. 

2. Select Autotest Preferences. 

3. From the open Autotest Preferences screen, set the preferences as required. 
Note: It is important that your fiber autotest settings match your certification 
requirements.  

SPECIFYING A MODULE (FIBER TYPE) 

The LANTEK must be configured by selecting the fiber test mode that corresponds to 
the FIBERTEK module installed in the handset.   

1. Select the Fiber Optics on the Display Handset Ready screen. The Fiber Cable Type 
screen appears. 

2. Highlight the option that corresponds to the installed FIBERTEK module. 

3. If the loss budget has already been set, press ENTER to continue with the 
previously set values.  
 
OR: 

4. Press the   key to enter the loss budget mode. 

Loss Budget Description 

The loss budget setting adjusts the pass/fail threshold for attenuation measurements 
made with FIBERTEK. Since the loss budget value does not affect the actual 
attenuation measurements, this function is for informative purposes only. When the 

measured attenuation is less than or equal to the loss budget, a  is displayed. If 

the attenuation is greater than the loss budget, a  is displayed. The loss budget 
can be set in one of two ways:  

Manual Loss Budget configures a fixed loss limit value for each applicable 
wavelength. This mode is useful when the acceptable system loss has been specified 
or when testing to application specific limits such as those listed in Appendix C, Fiber 
Optic Cabling Standards and Application Requirements. 
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Calculated Loss Budget lets FIBERTEK calculate the limits for each wavelength 
based on parameters you specify. Fiber length, number of connectors and splices, and 
maximum attenuation for each of these are entered into the calculator to determine 
the proper loss budget.  

Setting the Loss Budget 

1. Select a wavelength by pressing the F1–F4 keys. 

2. Use the ARROW keys and NUMERIC keypad to enter a value into the Loss Budget 
field.  

3. Select another wavelength with the F1-F4 keys and enter the loss budget. 

4. Press ENTER to complete the process. 

Calculated Loss Budget 

1. Choose a wavelength to adjust by pressing the F1-F4 keys. 

2. Press the SHIFT key and then select  to enter the Budget Loss Calculator. 

3. Using the UP/DOWN ARROW keys to move between fields, and the 
LEFT/RIGHT ARROW keys to scroll through a field, enter values with the 
NUMERIC keypad for cable length, loss/km, splices, connectors, and repair 
margin.  

4. Press  to update the budget then press ENTER to save. Repeat for each 
wavelength. Press 

 
again to store values and return to the READY screen. 

 

   

Figure 5-1: Calculated Loss Budget Screens 
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FIELD CALIBRATION (GENERAL) 

Field calibration allows the FIBERTEK to obtain a reference level for loss measurement. 
The accuracy of the field calibration depends on the amount of warm-up time allowed 
prior to starting the calibration process. 

 

Figure 5-2: Preferred Setup for Field Calibration 

Note: Allow the adapter a proper warm up time prior to field calibration. This will 
ensure specified accuracy. Be sure the launch cables are the same type of fiber as 
the cable being tested. (i.e. 50μm jumpers to test 50μm cabling) 
 
If the FIBERTEK unit has been stored in a location substantially colder than the area 
where measurements are to be taken, allow the unit to warm up to the ambient 
temperature with the protective dust caps in place to prevent condensation on the 
transmitter or receiver diode lenses. 
 
Thoroughly clean the laser and receiver lenses prior to attaching the launch cables 
using the Fiber Cleaning package supplied with your Basic or Premium Kit, which 
contains a high-quality cleaning solution and lint free wipes. Contact your local 
distributor for refills. 
 
Replace dust caps immediately after launch cables are removed. 

The setup depicted on this page is the normal calibration configuration for all tests 
that use both handsets. This includes Autotest as well as the Attenuation and Length 
tests, which are accessed through the Analyze menu. Calibration configuration for 
Loopback Attenuation is described later in this manual.  

The calibration data is recorded and stored by the Display Handset. The loss effects of 
launch cables and couplers that were present during field calibration are subtracted 
from the attenuation results during testing.  
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When testing fiber optic cable, a field calibration is recommended every time one or 
more of the following events occur: 

 Substantive physical movement or change to the launch cables  

 Change in fiber cable type  

 Change in the adapters  

 Power turned OFF or ON for either of the units 

 When the test setup is moved 

 When a connector is disconnected from the “TX” port of a FIBERTEK module 
 

PERFORMING A FIELD CALIBRATION 

1. Connect the Display and Remote handsets as indicated in Figure 5-2. Make certain 
that the patch cords connected are compatible with the fiber type under test (i.e. 
50μm vs. 62.5μm).  

2. Turn on both handsets. For best accuracy, wait 5 minutes to allow the lasers to 
warm-up and settle. During the warm up time, clean all couplers and launch cables 
and check launch cables for dirt, scratches, and chips with a fiber optic inspection 
scope. Clean the connectors inside the FIBERTEK modules with optical cleaning 
swabs as well. 

3. Select Field Calibration from the Ready screen and press ENTER. 

4. To start the field calibration process press the F1 key. Calibration takes about a 

minute after which you should see a  icon indicating the calibration was 
successful. If the calibration fails check for the following conditions, as they are the 
most common causes of failure: 

 Verify the polarity of the patch cords. The transmit port (Tx) of one module must 
be connected to the receive port (Rx) of the other module. 

 Dirty connectors on the patchcords. Clean and inspect with a fiber inspection 
scope (IDEAL #45-332).  

  Warning: Never look into a connector where the opposite end is connected to 
live equipment, including the FIBERTEK modules. 

 Clean the connectors on the FIBERTEK modules with cleaning swabs. Any dirt on 
patch cords will be transferred to the module connectors. 

 Check for continuity of patchcords with a fiber continuity tester (IDEAL #VFF5).  
 

AUTOTEST CONFIGURATION 

Having the correct test configuration is critical to achieving accurate test results. Since 
FIBERTEK is a dual-fiber test system, the test configuration will vary slightly from the 
usual methods used with single fiber test systems. 

There are two general methods used for calibration, and two methods used for testing 
with optical loss test sets such as FIBERTEK. These methods are described in the 
TIA/EIA 526-7 and 525-14 standards. These methods are commonly described as 
Method ‘A’ and Method ‘A’ Alternate. 
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METHOD ‘A’ 

Calibration Setup 

The Method ‘A’ calibration uses two launch cables and a set of couplers. This is the 
recommended calibration procedure for FIBERTEK, as it does not require disconnecting 
the launch cables from the modules.  

 

Figure 5-3: Method 'A' Calibration Setup 

Test Setup 

The Method ‘A’ test setup is best used for long fiber links where the majority of the 
attenuation is caused by the cable itself, not the connectors. With this configuration, 
the calibration reference plane is at the patch panel and work area outlet.  

The measurement taken will include the loss of the fiber optic cable (including inline 
splices and couplers) and the individual connector at each end of the link (one pair). 
Since there is only one pair of connectors included in this measurement, the overall 
loss values may be lower than one would expect, particularly when this setup is used 
to test very short cables.  

When used on long links of over 1km (multimode) or 4km (single mode) the loss of 
the connectors is small compared with the fiber, making this an acceptable setup for 
longer links. Use this configuration when knowing the loss of the optical fiber is more 
important than knowing the total link loss. 

 

Figure 5-4: Method ‘A’ Test Setup 
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METHOD ‘A’ ALTERNATE 

Test Setup 

The Method ‘A’ Alternate test configuration makes it possible to use a dual fiber test 
system while measuring the actual loss of all the connections and fiber optic cable. By 
using the ‘A’ Method for calibration and adding a new test jumper for testing, the 
Method ‘A’ Alternate is useful for testing short links where the connectors make up a 
large portion of the link attenuation.   

 

Figure 5-5: Method 'A' Alternate Test Setup 

 

Recommended Setup 
 

Calibration Method ‘A’ & Test Method ‘A’ Alternate 

1. Following a successful field calibration as described in Method ‘A’, disconnect the 
Remote Handset launch cables from the couplers.  

2. Connect another set of launch cables to the Display Handset launch cables. You 
should have two sets of launch cables connected to the Display Handset and one 
set connected to the Remote Handset.  
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PERFORMING A FIBER AUTOTEST 

Autotest performs comprehensive tests using programmed testing limits. An overall 
pass or fail is displayed along with individual test results.  

Fiber autotesting can be performed in either Multimode (in accordance with the 
TIA/EIA-526-14A Standards) or Singlemode (in accordance with the TIA/EIA-526-7 
Standards). 

Fiber Testing (Singlemode and Multimode) 

There are four types of test that can be performed: Duplex Length, Loopback Length, 
Loopback Attenuation and Dual Fiber Attenuation. 

Field calibration must be completed prior to performing tests. A field calibration is also 
recommended every time there is a change to the launch cables, fiber cable type, 
adapters, or when the power is turned OFF or ON for either of the units. 

 The attached adapters of the handset units should be allowed to warm up for a 
minimum of 5 minutes to ensure accuracy. 

 The launch cables of the same fiber type should be the same as the fiber to be 
tested.  Position unattached launch cable leads on a flat surface. Allow the fiber 
to relax but not dangle in the air. 

SETUP & CALIBRATION FOR LOOPBACK TESTING (SINGLE HANDSET) 

Loopback testing allows testing fiber links using only the display handset. This type of 
test is convenient for testing short links or patch cords since the use of a single 
handset is less cumbersome than dual handsets. When loopback mode is used, only 
one wavelength is measured. Additionally the length result is the round trip distance. 
Remember that when testing a two-fiber link, the actual length will be half the 
reported length. 

Field calibration for loopback testing requires only the LANTEK display handset, and 
sets the reference power level for attenuation measurements.  

1. Attach the desired FIBERTEK module to the display handset. Choose Fiber from the 
Ready screen. 

2. Select the single wavelength test that matches the module attached to the 
handset. 

3. Select a loss budget as described earlier in the manual. 

4. Select the Field Calibration option from the Ready Screen. 

5. Connect one end of the reference cord to the display handset. Connect the 
opposite ends together with a coupler and begin calibration by pressing F1. 
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Figure 5-6: Loop Calibration Setup 

LOOPBACK TESTING 

Loopback testing can be performed by using either pressing the AUTOTEST button or 
selecting Analyze on the Ready Screen. Autotest performs the attenuation and round 
trip length, while the Analyze modes test either attenuation, length, or loopback 
length. 

 

Figure 5-7: Configuration for Loopback Testing 
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A test result screen will appear at the completion of the test procedure. 

 

Figure 5-8: Loopback Test Results Screen 

LENGTH TEST (DUAL HANDSET) 

Configuration Setup for Length Testing 

1. With the appropriate test adapter on the Display Handset and the appropriate test 
adapter on the Remote Handset, connect one end of the near end launch cable 
leads to the TX and RX connectors on the Display Handset adapter. 

2. Connect the other end of the launch cable leads to the patch panel that connects 
to the fiber under test. 

3. Connect one end of the far end launch cable leads to the TX and RX connectors on 
the Remote Handset adapter.  

4. Connect the other end of the far end launch cable to the wall plate (fiber cable 
under test). 

5. Check all connections to ensure proper contact. Upon completion, you are ready to 
perform a fiber test. 

 

Figure 5-9: Configuration for Dual Handset Testing 

6. Press the LENGTH key on the Display Handset or select Analyze on the Ready 
screen and press ENTER.  

7. Then, select Length, and press ENTER. 

8. At the completion of the test procedure, a test result screen will appear. 
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DUAL WAVELENGTH ATTENUATION TEST SETUP 

1. With the appropriate test adapter on the Display Handset and the appropriate test 
adapter on the Remote Handset, connect one end of the near end launch cable 
leads to the TX and RX connectors on the Display Handset adapter. 

2. Connect the other end of the launch cable leads to the patch panel that connects 
to the fiber under test. 

3. Connect one end of the far end launch cable leads to the TX and RX connectors on 
the Remote Handset adapter.  

4. Connect the other end of the far end launch cable to the wall plate (fiber cable 
under test). 

5. Check all connections to ensure proper contact. Upon completion, you are ready to 
perform a fiber test.  

 

Figure 5-10: Dual Wavelength Attenuation Testing Configuration 

DUAL WAVELENGTH ATTENUATION TESTING 

1. Press AUTOTEST on the Display Handset or Remote Handset to begin the test, or 
select Analyze on the Display Handset Ready Screen and select Attenuation in the 
Analyze screen. 

2. When the Autotest is completed, the results of the test are displayed. 

3. Use the UP/DOWN ARROW Keys to view test results of different wavelengths. 

  

Screen Results thru Autotest process Screen Results thru Analyze process 

Figure 5-11: Dual Wavelength Attenuation Test Result Screens 
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TESTING WITH FIBER STANDARDS 

Certification of Fiber Optic Cabling is typically performed in accordance with the TIA-
568 or ISO 11801 Cabling Standards where a Pass/Fail criterion is based on the length 
of the cable and the number of splices and connectors in a fiber link.  In addition to 
these criteria, LANTEK can be configured to perform application specific fiber tests, 
which are useful when trying to determine whether a fiber link will support specific 
types of networking equipment such as 100BaseSX or 1000BaseLX. 

To utilize these options, please follow the steps below:  

1. From the DH Ready Screen, press <SHIFT>F3 or select the Fiber icon, press 
ENTER 

2. The Fiber Cable Type screen appears.  Highlight the option corresponds to the 
installed adapters and select the softkey “Fiber Std.” or F2. 

3. Use the UP/DOWN ARROW Keys to highlight the desired standards for testing, 
and press ENTER. 

4. The Fiber Standards screen appears.  Select the applicable core size (F1), 
wavelength (F2), and/or setting the loss budget (F3) keys.  Upon completion, 
press ENTER. 

 

   

 

5. LANTEK units are now ready for testing with specified Fiber wavelength and 
standards. 
Note:  With different Standards, different softkeys of operations are provided for test 
setup.  Refer to Appendix C – Fiber Optic Cabling Standards & Application 
Requirement for specific Fiber Standards. 
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INTERPRETING AUTOTEST RESULTS FOR FIBER OPTICS 

PASS/FAIL REPORTING  

The overall Autotest result is displayed at the top right of the Autotest display screen. 
Individual Autotest results are displayed to the right of each test. 

Overall Test Result Symbols 

Symbol Overall Autotest Result 

 
Overall test result is a pass if each individual test is a pass. 

 
Overall test result is a fail if one or more individual tests is a fail. 

 
Individual Autotest Reports 

Symbol Individual Autotest Result 

 
Pass - All values pass with sufficient margin. 

 
Fail - One or more values fail by a margin of failure greater than the 
instrument’s specified accuracy. 

SAVING CURRENT AUTOTEST RESULTS 

Autotest results can be stored in the LANTEK internal tester memory or Compact Flash 
memory card and accessed later using the Stored Results feature. Autotest results can 
be saved immediately following the test. 

 Only overall passed Autotests can be saved using the Autosave feature. Failed 
tests can be saved manually. 

 Test results are automatically saved if the AutoSave preference is enabled. Refer 
to Setting Preferences. 

 Test names are automatically assigned to completed tests when the Auto 
Increment feature is enabled. If a different name is desired, a test can be named 
manually using .  

MANUALLY SAVING AUTOTEST RESULTS (AUTOSAVE DISABLED) 

1. To manually save an Autotest, select , located at the bottom of the screen. 

2. The Test Saved screen will be displayed for a brief period, showing the name the 
test is saved under. 

3. If the current name already exists, a warning screen appears asking you to 
overwrite the currently existing file or enter a new file name. 

4. Press ESCAPE to exit and return to the previous screen without performing a save 
operation, or select  to overwrite the existing file. 

MANIPULATING JOB FOLDERS 

When an Autotest is saved, the data is stored with a unique name. Test results can be 
viewed, printed, or deleted from the Stored Tests screen. 

1. On the Ready screen, select Stored Tests to open the Job List screen. 

2. Highlight the desired Job. Press  to view the folder options list. 

3. Highlight the desired function and Press ENTER. 
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VIEWING RESULT DETAILS 

When an Autotest is saved, the data is stored with a unique name. Test results can be 
viewed, printed, or deleted from the Stored Tests screen. 

1. On the Ready screen, select Stored Tests to open the Job List screen. 

2. Highlight the desired Job. Press ENTER to open the job. 

3. Press the ARROW keys to highlight the desired test record. 

4. Press ENTER to open the record. 

5. Press ESCAPE at any time to return to the previous screen. 
 

MEASURING RETURN LOSS 

Simply stated, return loss is the ratio of power reflected by a connector or other event 
compared to the power that arrived at the event. The scale of measure for return loss 
is dB (decibel). Because the scale of return loss is by definition a negative value, a 
larger (negative) number is better.  

However, by convention, most people usually omit the negative sign and use it as a 
positive value. For example, a return loss measurement of 0 dB means that 100% of 
the power arriving at the connector was reflected back to the transmitter.  

In reality a 0 dB measurement is impossible in fiber-optic systems; the worst 
reflection possible is about –14 dB which would be created by a perfect glass-to-air 
interface. In most cases a field polished connector will yield a return loss of 
approximately  -30 to  -40 dB, meaning .1% to .01% of the power was reflected 
upstream. Factory terminated Ultra Physical Contact (UPC) connectors usually perform 
to –50 dB or better (.001% reflection). 
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CHAPTER 6 
FIBER OPTICS DIAGNOSTICS 

(TRACETEKTM) 

 

TRACETEK is a Reflective Anomaly Detection (RAD) system composed of two parts: 

 LANTEK Cable Certifiers, and 

 TRACETEK Optical Transceiver Module 

The LANTEK Display Handset provides power, user interface, storage and signal 
processing capability to the TRACETEK module. The TRACETEK module converts the 
LANTEK electronic TDR signals to optical and optical signals back to electronic. 

The primary use of this system is to locate optical reflections from cable discontinuities 
such as connectors, splices, fractures (i.e. cracked or broken strands) or other 
anomalies occurring within an optical fiber network.  

  Warning: The TRACETEK adapter generates light pulses exceeding 40 milliwatts 
of power. DO NOT look into the adapter or the fiber under test as serious eye damage 
may result. 

TRACETEK is an alternative to using an OTDR (Optical Time Domain Reflectometer) 
and functions in a similar manner. Both methods will produce traces of optical back 
reflection for analysis by technicians. However, the Rayliegh scatter measurement 
used by the OTDR to infer fiber loss is not used in TRACETEK.  

Note: True loss measurements can only be made with an Optical Loss Test Set such 
as TRACETEK’s companion product, FIBERTEK. 

TRACETEK VS. OTDR 

OTDR OPERATING PRINCIPLES 

The OTDR (Optical Time Domain Reflectometer) is a device that is able to “look” at a 
fiber optic cable and display a graphical representation of the events that occur on the 
cable. The basic concept is that a high-speed laser fires a precise pulse of light into 
the fiber, after which the device monitors the same fiber for reflections. The time 
between the launched pulse and reflected pulses represents the distance to the events 
that caused the pulses. This gives the OTDR the ability to not only measure the length 
of the fiber but to also measure the distance to each event on the fiber. This function 
allows the OTDR to be used as a trouble-shooting tool to find breaks in the fiber and 
to identify the location of individual connectors and splices. 

The second feature of an OTDR is its ability to measure the tiny amounts of light that 
are reflected back by the fiber optic cable itself. This phenomena is known as Rayleigh 
scattering and is caused by light reflecting off molecules in the glass whose diameter 
is 1/10 the wavelength of the light. This is the same phenomenon that makes the sky 
appear blue. When the OTDR is able to detect these tiny reflections it can calculate the 
loss of the cable as well as the insertion loss of connectors and splices on the fiber 
cable. 
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Figure 6-1: OTDR Block Diagram 

OTDR History 

OTDRs were first used in long distance outside plant fiber optic installations such as 
telecom or CATV to help document and troubleshoot fiber networks. The first 
generation OTDRs were massive, complex and very expensive. Most models required 
the use of a cart or dolly of some type to be moved, as they were heavy and bulky. 
These early machines did not offer any of the automatic setup features we are used to 
seeing today, meaning that the operator had to have a very thorough understanding 
of the operation of the equipment to properly configure it.  

Today, OTDRs are smaller, less expensive and easier to use. But that still does not 
mean that the average installer can pick one up and begin using it. The technician still 
needs to understand the complex relationship between pulse width, dynamic range, 
acquisition time, Rayleigh scattering, and a myriad of other factors that determine 
what type of picture the technician will get from an OTDR.   

 

Figure 6-2: Typical OTDR Trace 
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TRACETEK OPERATING PRINCIPLES 

TRACETEK is able to provide most of the troubleshooting functions of an OTDR at a 
fraction of the cost with a simple, easy-to-use interface that requires almost no 
training. Like an OTDR, TRACETEK fires a precise laser pulse into a fiber and monitors 
the fiber for return pulses. This means that like an OTDR, TRACETEK can measure the 
overall length of a fiber, as well as measure the distance to reflective events within 
the fiber.  

Unlike an OTDR, TRACTEK is exceptionally easy to use. The only setup consists of 
choosing from one of three operating modes (High, Medium, or Low Resolution). The 
lightweight module is small enough that it can be carried in the installer’s test 
equipment case, making it available in any situation that requires fiber 
troubleshooting. Since TRACETEK does not measure fiber scattering, it cannot 
measure the insertion loss of the link or individual connectors like an OTDR. 

Unlike fiber test kits that also measure overall length, TRACETEK only needs to be 
connected to one side of the fiber to make its measurements. Traditional fiber test kits 
need to either have hardware connected at both ends of the fiber, or a loop-back cable 
installed at the far end to make its length measurement. This means that two 
technicians are required to test the length, or one technician can perform the test by 
walking back and forth to test each strand, taking twice as long to finish the job. 

USING TRACETEK  

The TRACETEK module uses a very high-power infrared laser for both multimode and 
single mode testing. The light emitted from TRACETEK is invisible, so take care when 
using TRACETEK or examining connectors not to look directly into the connector or 
examine it with an inspection scope unless you are certain the module is powered off 
or disconnected.  

With the TRACETEK module attached to LANTEK, connect the module to the fiber 
under test with the included FC-ST (FC-FC for single mode) launch cable. Unlike an 
OTDR, TRACETEK does not require the use of long launch cables; its dead-zone is 
short enough that any jumper of 2 m (6 ft) or more can be used.  

1. With the TRACETEK module attached to LANTEK, connect the module to the fiber 
under test with the included FC-ST (FC-FC for single mode) launch cable. Unlike an 
OTDR, TRACETEK does not require the use of long launch cables; its dead-zone is 
short enough that any jumper of 2 m (6 ft) or more can be used. 

2. Turn on the power to the LANTEK. Choose the Analyze icon, press ENTER. 

3. In the TRACETEK Analyze menu there are three options to choose from: High 
Resolution, Medium Resolution and Low Resolution. This setting will change the 
pulse with “laser power” that is fired into the cable. In this case resolution is the 
opposite of distance, meaning that the short cables are better tested with High 
Resolution and long cables are better tested with Low Resolution. 
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Table 6-1: Resolution Settings and Recommendations 

Resolution 
Setting 

Power Distance 
Scale 

Distance Recommendation 

High Low Short 0-800 m (0-2625 ft) 

Med High Short 250-850 m (820-2790 ft) 

Low High Long 500-4000 m (1640-13120 ft) 

Note: The recommendations for distance do not reflect the absolute minimum or 
maximum distance capabilities of TRACETEK. These are recommendations that will 
yield the best results in most cases. You should feel free to experiment and 
determine the setting that gives the best result for a particular test configuration. 

HIGH RESOLUTION 

High Resolution provides accurate back reflection measurement of fiber and will 
resolve individual events as close as 2 meters apart at rated accuracy. This setting is 
used to check for connector quality, optimized for short-distance cables with lengths of 
no more than 800 meters and mostly used on horizontal links and shorter backbone 
cables. This mode has a “low power” setting. 

MEDIUM (MED) RESOLUTION 

Medium Resolution provides accurate back reflection measurement of lengths and will 
resolve measure events 8 meters and up at distances of 850 meters. This setting is 
primarily used to locate high quality connections for documentation purposes. It is on 
cables between 250-850 m in length or when trying to locate low-reflection events 
such as mechanical splices or connectors where the polish is so good that they do not 
reflect enough light in the low power mode to be detected. This mode has a “long 
laser pulse” setting. 

LOW RESOLUTION 

Low Resolution provides accurate back reflection measurements for cables between 
500 and 4000 meters in length, since most connectors and mechanical splices will be 
visible in this mode. This mode combines the “high power/long pulse” of the Medium 
Resolution mode with long-distance scaling. 

TRACETEK OVERVIEW 

High-bandwidth optical networks have become increasingly sensitive to signal 
transmission problems. In many cases the channel insertion loss is the only parameter 
that is measured to make a determination that a link’s performance is satisfactory. 
Channel insertion loss only measures the weakening of the signal from one end of a 
fiber optic link to the other, making sure that enough optical power is present at the 
receiver to ensure the optical transceivers can “see” each other.  

FIBERTEK is an exceptional tool to certify proper link channel loss. However, in a 
situation when a certification test fails or there are unusual network performance 
problems, another tool can help isolate cabling problems.  

TRACETEK is a unique tool that provides many of the useful features of an OTDR 
without the high cost or complex parameters to set up. An easy to use diagnostic tool, 
TRACETEK allows the user to measure the total length of a link, measure the distance 
to a reflective event such as a connector, and most importantly, identify faulty 
connections.  
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TRACETEK works by launching a high-power laser pulse down the fiber and monitoring 
reflections returned by the end of the cable, connectors, mechanical splices, and cable 
breaks. This important functionality will help locate sources of excessive reflection in 
the cabling system. Excessive reflection in an optical system leads to high bit error 
rates, preventing the network from operating at its full capability.  

One of the most common sources of excessive return loss is dirty or poorly polished 
connectors. When there is too much reflection in a system, the reflected power can 
interact with the downstream signal, either increasing or decreasing the amplitude of 
the transmitted signal. Additionally, if the reflection is strong enough it can interfere 
with the feedback circuit on the laser transmitter causing fluctuations in output power. 
Unlike a power meter, which measures the loss across a link, TRACETEK displays the 
relative reflection of events in a link allowing the user to isolate and remedy problems. 

TRACETEK DISPLAY 

After deciding which setting is best for your situation, select the appropriate mode and 
press ENTER. TRACETEK will sample the fiber for about 30 seconds before displaying 
the acquired trace data. 

 

Figure 6-3: TRACETEK Display 

 

Table 6-2: Key Elements of the TRACETEK Display 

1 Start pulse (first connector) 

2 Reflective events 

3 End of fiber (last connector or break in cable) 

4 Moveable Cursor 

5 Total length of fiber 

6 Cursor position 
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TRACETEK displays its measurement data in a graphical format similar to that of an 
ODTR, with the X-axis representing the distance from the handset and the Y-axis 
displaying the relative reflection (Return Loss) of each event. TRACETEK instantly 
displays the overall length to the end of the fiber and allows the operator to scroll a 
cursor to find the distance to any event on the screen. This functionality allows the 
operator to quickly measure overall fiber length, locate breaks in the fiber, locate 
individual reflective events, and check the relative reflection of events to identify 
defective connections. 

The TRACETEK display provides a “roadmap” of the fiber at a glance. The number at 
the bottom of the screen, marker 5, indicates the measured distance to the end of the 
fiber. As with an OTDR, TRACETEK does not require a piece of equipment or a person 
at the opposite end of the fiber under test. For this reason, TRACETEK cannot 
differentiate between the expected end of the fiber or a break in the cable. If there is 
a break in the cable this reading will tell you how far down to look for the break.  

 Marker 1 indicates the first connector attached to your launch jumper.  

 Marker 2 indicates the two connectors in the middle of the fiber under test. The 
height of the reflected pulse (called a Fresnel) indicates the relative reflection of 
each event. In the High-Resolution mode, a good connector should not go much 
above the halfway point on the display. In this example, the two connectors 
should be cleaned, and the first appears to be a bit worse than the second.  

 Marker 3 is at the end of fiber. This reflection is expected to be quite large since 
it is at the end of the cable and represents a glass-to-air interface.  

Markers 1 and 6 indicate the user-moveable cursor and its position respectively. The 
cursor can be move by three methods: in very fine steps using the left and right arrow 

keys on the keypad, in medium size steps using the  and  soft-keys, or 
in large steps by holding the SHIFT button while pressing the LEFT/RIGHT ARROW 
keys on the keypad.  

 

In the figure above, the display shows a trace of the same fiber as before, but the two 
connectors in the middle were cleaned using the IDEAL Starter Cleaning Kit included 
with your TRACETEK module. It is clearly evident that a dirty connector, even one that 
appears clean to the naked eye, can cause significant return loss problems in the link. 
After being cleaned, both connectors are well below half scale and should present no 
problems with network operation.  

Cleaning connectors with any fiber-optic system is of utmost importance. Whenever 
there is any doubt about a test result, the first action is to clean the suspect 
connectors and retest the link. 
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There are many creative ways to clean connectors, and we’ve seen quite a few of 
these methods used in the field. It’s also common that test technicians do not take the 
time to visually inspect or clean connectors before testing the link. Some technicians 
will check for cleanliness with their naked eyes, but the human eye cannot possibly 
see the type of contaminants that affect fiber-optic connectors. Cleaning is a mundane 
but very important task.  

To illustrate this point, we have provided some magnified images of connectors 
cleaned with various methods. 

 

Dirty 
connector 

 

Wiped 
“clean” 

with finger  

 

“Cleaned” 
on shirt 

 

Cleaned 
w/IDEAL 

cleaning kit  
 

 

Again, using the same fiber, but before the connectors were cleaned, the figure above 
displays the results when the optimal TRACETEK resolution mode is not selected. In 
this case the Medium Resolution mode was used. The resulting Fresnels are much 
higher than before and the “Batman ears” are caused by the saturation of the 
receiver. This is due to excessive reflection.  

 

 6-7 
 



Chapter 6  
Fiber Optics Diagnostics (TRACETEK) 

 

 

After cleaning the two center connectors, shown in the figure above, it is apparent 
there is some improvement in return loss. However, in this case we expect the Fresnel 
to be larger than before because of the higher launch power TRACETEK uses in the 
Medium Resolution mode. Also notice that the Fresnels are wider than before. This 
width is known as the dead zone, which is the distance that the receiver is blinded by 
the reflection of each event. High output power and dirty or poorly polished 
connectors will lead to an increased dead zone.  

In its High Resolution mode with clean connectors, TRACETEK will have a dead zone of 
2 m, while in the Medium and Low Resolution Modes the dead-zones will be about 8 
m. When testing through patch panels or other cross-connect devices best results will 
be achieved with the High-Resolution mode. Refer to Table 1 when deciding which of 
the three resolution modes is best for your application. 

TESTING WITH TRACETEK  

The TRACETEK system is simple to use and requires no warm-up time. 

1. Insert the TRACETEK adapter into the LANTEK Cable Certifier. 

2. Clean the launch cable and attach it to the adapter. 

3. Using a Good Quality mating adapter, attach the launch cable to the fiber to be 
tested. Clean all connections. Make sure the launch cable connector is aligned with 
the TRACETEK connector slot to assure proper mating of the connector. 

 

Figure 6-4: LANTEK/TRACETEK Configuration on a Fiber 

4. Select Fiber Optics on the Display Handset Ready screen. The Fiber Cable Type 
screen appears. 

5. Highlight the desired fiber type and press ENTER to accept the new fiber type.  

6. From the Ready screen of the LANTEK main unit, Press AUTOTEST or select 
Analyze to open the Analyze menu screen. 

7. The Analyze menu provides three resolution options: High, Medium, and Low. The 
default resolution is High.  

6-8  
 



 Chapter 6 
Fiber Optics Diagnostics (TRACETEK) 

 

 

Figure 6-5: TRACETEK Analyze Menu Screen 

8. Highlight the desired resolution and press ENTER. The LANTEK Cable Certifiers will 
conduct the measurement. 

9. When the test is complete, the results are displayed on screen, left to right, with 
the last event usually taking place at the end of the fiber. 
Note: Sometimes the end of the fiber (EOF) is not where it is expected due to poor 
splices or cuts. EOF is the point where TRACETEK detects a large reflection  
(about -14dB) which can be the actual EOF, a bad connector, or a break in the fiber. 

 

Figure 6-6: TRACETEK Test Results Screen 

Using the high resolution setting is best for cables under 800 m (2625 ft) in length.  

The distance to the end of the fiber is displayed on the screen in the lower left-hand 
corner of the display. The vertical cursor can be used to find the distance to an event 
by moving it along the trace where the event is indicated. The distance to this point 
appears on the screen in the upper right-hand corner of the display. 

 

SAVING TRACETEK RESULTS 

Like other tests, the resultant plot from TRACETEK can be stored in the LANTEK 
handset and recalled or uploaded to a PC using the LANTEK Reporter software.  

1. From the TRACETEK display, press SHIFT and the  key. 

2. Enter a test record name and press ENTER to save the record. 
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TROUBLESHOOTING WITH TRACETEK 

TRACETEK can be an invaluable tool for troubleshooting a variety of network 
problems. One application is to locate a break in a cable. In a new installation, 
TRACETEK can be used with a power meter/light source test kit such as FIBERTEK to 
characterize a link and map the distance to known events.  

In this example we’re testing a backbone link consisting of 44 m of cross-connect 
cable to a 717 m backbone, followed by another 40 m of cross-connect. Figure A is the 
FIBERTEK (power meter/light source) result from the link indicating a passing result.  

In Figure B, we see the connectors at 40 m and 760 m, as well as the end of the fiber 
at 801m. The connectors at 40 m and 760 m appear to be in good condition with a 
reflection that is just below half scale. 

  

Figure A     Figure B 

Figures C and D show the same link failing. The FIBERTEK screen tells the degree of 
link failure but it does not help isolate the problem. TRACETEK screen (Figure D) 
shows the connector at 761 m is nearly full scale, an indication that it has become 
dirty or damaged.  

  

Figure C     Figure D 

In this situation, the best course of action is to clean the connection at 760 m and 
check it with a microscope (IDEAL P/N 45-332) before re-testing. Consult the 
instructions included with the IDEAL Starter Cleaning Kit for the best methods to clean 
connectors and couplers. 
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Q&A: IDENTIFYING TRACETEK CONFIGURATION PROBLEMS 

Q1: Why is it so important that my launch cable connectors be kept clean? 

A1: Unlike a traditional light source, the most high-powered of which have output 
levels significantly less than 1mW, TRACETEK’s high-power laser source launches up 
to 40 mW of power. When dealing with return loss measurements, more power out 
means more power back. With the levels that TRACETEK operates at, a dirty launch 
cable will immediately reflect a large amount of power back at the detector, essentially 
causing temporary blindness of the detector. Keep your connectors clean! 

Q2: What will happen if I set the Resolution incorrectly? 

A2: Incorrectly setting the Resolution of TRACETEK will not cause any damage to the 
tester or cable. It will usually result in a garbled display that is a result of too much 
power being injected into a short cable, leading to very high reflections since the cable 
itself cannot attenuate the return pulse. Or, in the case of a very long cable, there will 
not be enough power for TRACETEK to see the end, meaning it will be unable to 
properly scale the screen. Here are a few images that result when the Resolution 
setting is not optimally set for the fiber being tested (Figures E-H). 

 In this example a 1000 m cable was tested with the Resolution set to MED. The 
result is that the ramp time, which adjusts the scaling, is too short. The 
recommended maximum distance for MED mode is 850 m. Change to LOW 
Resolution and try again 

 

Figure E 

 With the Resolution now set to LOW, the end of the 1000 m fiber is clearly 
visible. 

 

Figure F 
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 Here, a 45 m cable is tested with the MED Resolution mode. Although the length 
of the cable is correctly identified, there is so much power that the receiver is 
detecting echoes in the cable. Choosing the HIGH-Resolution mode should help. 

 

Figure G 

 In the HIGH-Resolution mode the power output is decreased and the echoes are 
eliminated. Also that notice the dead-zones of the first and last events are 
noticeably narrower. 

 

Figure H 

Q3: Why is TRACETEK only available in 1300 nm modules? 

A3: Since TRACETEK does not make attenuation measurements, the reason for 
choosing a 1300 nm laser is based purely on performance. Multimode fiber has less 
than half the attenuation at 1300nm than it does at 850 nm. By using the 1300 nm 
laser, TRACETEK can be used to test much longer cables than it could with an 850 nm 
laser whose power attenuates very rapidly.  

Q4: Does TRACETEK support single mode testing? 

A4: Yes. TRACETEK is also available in a single mode kit with a 1310 nm laser. For 
single mode fibers the attenuation difference between 1310 nm and 1550 nm is small 
enough that there is no major performance gain obtained by operating at 1550 nm. In 
this case the 1310 nm laser helps make TRACETEK the most affordable solution for 
reflectance testing of single mode fiber. 
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Q5: If I lose my TRACETEK launch cable, do I need to replace it with a special 
one? 

A5: No, the included launch cable with TRACETEK is an ordinary FC-ST multimode or 
FC-FC single mode jumper. Any high-quality replacement jumper will work, and there 
is no calibration necessary. The length of the launch cable is only important in that its 
length is added to your distance measurements and keeping a conveniently short 
cable will minimize any offset in length measurements. TRACETEK utilizes a special 
technology that allows the use of very short launch cables, unlike an OTDR whose 
front-end dead zone may be 20-100 m long and require the use of very long launch 
cables.  
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SYSTEM REQUIREMENT 

Your PC should have the following capability: 

Minimum Pentium 90, Windows 95B, 32 MB RAM, 100 MB of available disk storage, 
one serial communications port, video card capable of providing 
resolution of 1024 x 768 and an inkjet printer. 

Recommended Pentium 300 MHz, one of the following (Windows 98, ME, XP, 2000, or NT 
SP5), 128 MB RAM, 100 MB available disk storage, video card capable of 
providing resolution of 1024 x 768, a laser printer and an available USB 
port. 

Note: Windows 95 and Windows NT do not support USB connections. Uploading test 
results in these operating systems are therefore limited to a serial port connection. 

LANTEK REPORTER INSTALLATION AND START-UP 

LANTEK REPORTER UPGRADES 

The CD supplied with your tester may not contain the latest version of the LANTEK 
Reporter program. Ideal Industries provides a web (www) site for LAN cable test 
products that allows you to use a PC and modem to obtain the latest LANTEK Reporter 
maintenance release. Refer to Appendix B, World Wide Web Services. 

INSTALLATION PROCEDURE 

The LANTEK Reporter software is installed using the standard Windows program 
installer. 

1. Insert the LANTEK Reporter CD-ROM. 

2. Click on the Start button, and then click Run. 

3. Type, d:\ setup 
Note: If your CD-ROM drive is not the “d” drive, replace “d” with the correct drive 
letter. 

4. Follow the instructions on your screen. 
Note: Install the LANTEK Reporting System in the default directory, c:\…\ LANTEK 
Reporter. An empty database will be created in c:\…\ LANTEK Reporter \db. 
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Figure 7-1: Typical Installation Window 

STARTING THE LANTEK REPORTER PROGRAM 

There are two ways to start the LANTEK Reporter program: 

1. From the Windows desktop, select LANTEK Reporter. 

2. From the Windows desktop select Start. Then, select Programs, LANTEK Reporter. 

 

TESTER-TO-PC CONNECTIVITY 

PC CABLES 

Use the USB or the Serial Port interface cables supplied with your tester.  

USB Interface Cable 

The USB (Universal Serial Bus) interface cable is supported by the Windows 98 SE, 
ME, 2000, and XP (Pro and Home) operating systems and can upload data 
approximately 20 times faster than uploads via the serial port. The USB interface 
provides the same functionality as the serial port but does not support printing.  

Serial Port Interface Cable  

The serial cable, commonly referred to as a Null modem cable, connects to the RS-232 
serial port and is capable of uploading data (test results) to the PC or laptop as well as 
establishing a connection to a serial port printer. 
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If you supply your own serial port cable, Figure 7-2 shows the wiring specifications. 

 

 

Figure 7-2: PC Uploading Cable Pinout 

 

ESTABLISHING A CONNECTION 

 

Figure 7-3: PC to Tester Connections 

For USB Connection 

1. Attach the USB cable to the tester and an available USB port on the PC. 

2. Turn on the tester. The tester has an Operating System and must complete 
booting up before actions can be taken.  

3. After Booting is complete, press F2. Then select USB by pressing F3. 

4. Designate an upload location. 

5. From the LANTEK Reporter’s File Menu select Upload From Tester or select the 
Upload Test icon on the Toolbar to complete the Upload. A “Browse for folder” 
dialog appears. A new drive should appear as a “Removable Disk (E:) Double Click 
on the drive and a sub-folder should also appear. Click once on the “Stored Tests” 
folder to select it, then click the OK button. 
Note: Drive letter may vary depending on the number of drives installed on the user’s 
PC. 
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For RS-232 Serial Connection 

1. Attach the RS-232 cable to the tester and an available RS-232 port on the PC. 

2. Turn on the tester. The tester has an Operating System and must complete 
booting up before actions can be taken. 

3. Start the LANTEK Reporter program on the PC, go to the Options menu and select 
Upload Target. Then, select Comm Port. 

4. Designate an upload location. 

5. From LANTEK Reporter’s File Menu select Upload From Tester or select the 
Upload Test icon on the Toolbar to complete the Upload. 

For a serial port connection that is not responsive: 

1. Go to the LANTEK Reporter Options menu and select the Tester ID command. 
The program will automatically scan the available communications ports and baud 
rates to locate and identify the attached Tester. If the tester is not identified, 
proceed to the next step. 

2. Some PCs may have difficulties with this function and the following dialog box 
displays. Click OK. 

 

3. Shut down any other applications that use the serial communication ports. 

4. Click on the Options menu and select the Serial Port command. Select the 
correct Port and match the Baud Rate to that of your LANTEK tester. 

5. After you have entered the values, click the Test button. If the Tester is identified, 
its serial and model numbers will be displayed. 

6. Click OK. 
Note: If you have tried alternative baud rates and ports and LANTEK Reporter still 
cannot find the Tester, call IDEAL INDUSTRIES Customer Support. 

For Compact Flash Transfer 

1. Insert the Flash card with the test results into the Flash Card Reader on the PC. 

2. Start the LANTEK Reporter program on the PC, go to the Options menu and select 
Upload Target. Then select USB Compact Flash. 

3. From LANTEK Reporter’s File Menu select Upload From Tester or select the 
Upload Test icon on the Toolbar to complete the upload. A “Browse for folder” 
should appear. A new drive should appear as a “Removable Disk (E:)” Double Click 
on the drive and a sub-folder should appear. Click once on the “Stored Tests” 
folder to select it. Then click the OK button. 
Note: Drive letter may vary depending on the number of drives installed on the user’s 
PC. 

7-4  
 



 Chapter 7 
LANTEK REPORTER Software 

 

LANTEK REPORTER USER INTERFACE 

THE MENU BAR 

The menu bar at the top of the screen displays the pull-down menu names. 

 

When you choose a menu, a list of commands drops down under the menu. You can 
choose only the commands that are solid black. Gray commands or options are 
disabled or may be context-sensitive. For example, to use test commands such as 
Find Test and Select Test, the cursor must be in the test grid portion of the screen 
or the commands are not available. 

To open a menu 

1. Move the mouse so that the tip of the mouse pointer is on the desired menu. 

2. Click the left mouse button. 
 

The File Menu 

Many of the selections on this menu are standard Windows options. 

 

 

 7-5 
 



Chapter 7  
LANTEK REPORTER Software 

 

 

 
Command Description 

Upload From Tester  Pull result data from the LANTEK tester.  

Pack Tester Memory Erase all tests in the tester memory that are marked for deletion 
(Serial mode only).  

Erase Tester Memory  Erase all tests in the tester memory. 

Upgrade LANTEK 
Firmware 

Copy new firmware code to the LANTEK tester. 

Upgrade LTxxx 
Firmware 

Copy new firmware code to the LTxxxx tester. 

Export  Export test results as Comma-Separated Values (CSV) or standard 
ASCII text files. 

Backup Database  Archive current data in the current folder. 

Restore Database  Restore a closed database from a zipped archive file into the current 
folder. 

Re-Index Database  Re-index the database. 

Archive  Create a backup zip file of databases. 

 

The Edit Menu 

Click Edit to display the Edit menu. The Edit menu will vary based on which view (Job 
or Database) you are in. 

Job View 

 

 
Command Description 
Add Job Add a Job. 

Edit Job Modify a Job. 

Edit Tests Edit test information such as Test Company/Contractor, and names. 

Select Job Select an item in the database view in preparation for printing or 
reporting. 

Select All Select all entries in the database view. 

Find Job… Locate a database item. 
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Database (Test) View 

 

 
Command Description 
Edit Test Modify a test name and details. 

Select Test Select a test in the database view for printing or reporting. 

Set Operator Provide details about the operator for the currently selected test. 

Find Test Locate a database test item. 

Note: In order to activate the Test View, at least one Autotest must be activated in the 
right main section of the screen. In the left section, the job tree (see Job View) is 
shown. 

The View Menu 

The View menu allows you to hide or display the toolbar or status bar and view.  

 

While in database (test) view, select a test and click Test Information to open the 
Test Information window.   
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The Test Summary Information is located at the top of the screen. 

Command Description 

Job Name The name of the job to which this test belongs. 

Customer The customer for whom the test and job have been performed. 

Test Standard The standard used by the handset to perform the test. 

Date The date the test was performed. 

Operator The name of the operator who performed the test. 

Test Instrument The type and serial number of the instrument used to perform the 
test. 

Frequency Range The test frequency range of the tested cable. 

NVP The Nominal Velocity of Propagation value defined for the cable on 
which the test was performed. 

 
Individual tests can be viewed by double-clicking on a test tab to display stored test 
results.   

 A red dot on a test tab indicates one or more tests within the tab failed.  

 A green dot indicates that all tests within the tab passed.  
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The Options Menu 

Use the Options menu to configure the program to match the hardware and user 
preferences. 

 

 
Command Description 

Sort Sort tests in the database view. 

Units Choose feet or meters as the measurement units for both the screen 
display and printouts. 

Serial Port Configure the serial port for your LANTEK tester. 

Upload Target Designate the source of the data.  

Font Change the screen display font. 

Language Change the language for both the screen display and printouts. 

Tester ID Locate and identify a connected tester. (Serial mode only) 

 

The Help Menu 

This menu provides the standard windows Help support and displays the About dialog. 
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THE STATUS BAR 

The Status Bar at the bottom of the screen lists the functions that are currently 
operating and indicates the number of tests residing in the currently highlighted job.  

 
 

THE TOOLBAR 

The toolbar icons are shortcuts for many of the commands on the pulldown menus. 

LANTEK Unique Tool Button Identification 

 

Export 

 

Backup 

 

Upload Test 

 

Select All 

 

Find Tester ID 

 

Sort Test 

 

Set Operator   

 

THE RIGHT MOUSE BUTTON 

The right mouse button provides a shortcut to either display the Job or Test Edit menu 
depending on the area of the window where the click is performed.  
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LANTEK REPORTER HELP SYSTEM OVERVIEW 

HELP TOPICS OPTION 

The Help Topics menu option is the primary way to gain access to the LANTEK 
Reporter Help system. 

To open the Help System 

1. Pull down the Help menu and click the Help Topics command. The Help Topics 
screen displays. 

HELP TOPICS SCREEN 

The LANTEK Reporter Help Topics screen contains three tabs and three buttons. 

The Content tab displays a list of topics in the LANTEK Reporter Help system, 
organized by category. 

The Index tab is similar to a traditional book index, listing keywords and phrases 
alphabetically. 

   
 

The Find tab allows a search for any word or phrase in the Help system. 

 
 

Display button Open the selected LANTEK Reporter Help item. 

Print button Print the selected item. 

Cancel button Close the LANTEK Reporter Help system. 
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USING HELP SCREEN 

The Using Help screen consists of four tabs and a menu bar. The screen contains 
instructions for using and customizing the LANTEK Reporter Help system. The Web 
Help feature allows you to access Microsoft Product Support Online. 

 

ABOUT LANTEK REPORTER SCREEN 

The About LANTEK Reporter screen displays the LANTEK Reporter version number 
running on your computer. 

 
Note: The appearance of this screen depends on the operating system. 

 

UPLOADING DH TESTS TO THE PC 

The LANTEK tester is capable of storing tests in individual job folders that can be 
uploaded to the PC. To upload a job folder to the PC, you must create a new job folder 
on the PC or use an existing job folder before uploading the tests. 

To create a new database, refer to Creating a New Database. To create a new job 
name, refer to Adding a Job. 

UPLOAD PROCEDURE 

1. Designate the upload location (database) on the PC or Laptop. Before uploading 
test data from the LANTEK DH, select a destination database in the Database View. 
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2. From the File menu, select Upload From Tester. The Upload dialog box displays. 

 

3. Click the desired Upload Test Type button. 

4. Select a job in the Select Upload Job text box. 
Note: If you want to add AutoTests from a job in the cable tester to an existing 
LANTEK Reporter project with the same name, you have to select the mother project 
as <upload job>, that is located one level higher. (For example, for JOB 1 in the cable 
tester, select <LANTEK> as the upload job)  

5. Select a Data Source. Click OK to begin the uploading process. 

 Select Comm Port for direct connection (Serial) with the tester.  

 Select USB/PCMCIA Compact Flash if you have stored the test results on the 
compact flash card and are using the USB flash card reader. 

 Select USB LANTEK if you have stored test results in the LANTEK Internal 
Memory. 

 Select Browse for Tests if you have Stored Tests kept on a local or network 
drive. 
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6. With USB/PCMCIA Compact Flash selected, the following dialog will appear. Click 
OK to continue; CANCEL to exit.  

 
 

7. A status box will remain on screen during the uploading process and you will have 
the option to cancel at any time. 

 
Note: If you want to use the USB port under Windows 98 SE, you will need special 
drivers. These can be found in the subdirectory \WIN98 USB Driver in the LANTEK 
REPORTER folder. The Windows 98 USB drivers must be installed before using the 
USB interface. 
 
To install the drivers, proceed as follows: 
Start Windows Explorer and go to the \WIN98 USB Driver subdirectory. Right click on 
the file USBLS120.INF and select INSTALL. 

 

WORKING WITH THE DATABASE 

On start-up, the database that was opened last will automatically reload. 

Note: The first startup of LANTEK Reporter will load an ‘empty’ database (c:\LANTEK 
Reporter\...) from the database directory.  

7-14  
 



 Chapter 7 
LANTEK REPORTER Software 

 

CREATING A NEW DATABASE 

1. Select New command on the File menu or click the Create a new database icon on 
the toolbar. 

 

2. You can either type the new path and database name or choose Browse and 
select an existing path and then type in the database name. 
Note: The name of the new database displays only in the title bar of the main window. 

3. Click OK to enter your selection. 
Note: We recommend creating a new database for each new customer. When all of 
the reporting has been completed, make a final database backup and move the file off 
the computer to another media device (i.e. CD ROM or backup disk). This practice will 
ensure the optimum performance and test data integrity. 

OPENING AN EXISTING DATABASE 

1. Select Open on the File menu or click  on the toolbar. 

 

2. Use the Browse feature to locate the desired database folder and file. 

3. Click OK to open the database. 
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WORKING AT THE JOB LEVEL 

NAVIGATING THE JOB TREE 

Tests are stored in folders called Jobs. For example, each floor of a building can be 
listed as a separate Job. Another Job can represent the entire building or just those 
tests conducted by a particular technician.  

The left side of the Database View shows the hierarchy of Jobs. Clicking on a Job 
folder that is preceded by a plus (+) sign reveals the Jobs it contains. This hierarchy 
can be up to five levels deep. 

 

Jobs that have attached test records are indicated by a  icon. When you click on 
this icon, the test records become visible on the right side of the screen.  

You may move Jobs from one folder to another by selecting and dragging them. The 
current selection is indicated by a highlight bar.  

ADDING A JOB 

You must click on the left side of the main database view for the Add or Edit Job 
functions to be available. You can create a new collection of tests by adding a Job 
folder. 

 

1. Select the folder that you want to add a Job to. 
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2. From the Edit menu, click Add Job. The Add Job dialog box displays. 

 

3. Type in a name for the Job folder and any notes you want to add.  

4. Click OK to create the new job folder. 

 
Note: An alternate method of initiating the Add Job function is to right click the 
mouse on the job list where the new job is to be defined as a sub job. 

EDITING A JOB 

To change the name of a Job folder or attach text notes to it: 

1. Select a Job 

2. From the Edit menu, click Edit Job. The Edit job dialog box appears.  

 

3. Click on the Name or Notes text boxes to perform the desired edits. 
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4. Click OK when you are finished. 

 
 

ADDING OR EDITING CUSTOMER DETAILS 

You may want to add or modify customer details for a specific Job entry. 

1. From the Edit menu, select Edit Job. 

2. Click Customer. The Add Customer or Modify Customer dialog box displays. 

 

3. Add new customer information or edit existing information. If a customer name is 
supplied it will appear at the beginning of a report. 
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ADDING OR CHANGING THE TEST SET OPERATOR NAME 

You may change the operator name for one or more tests. An operator name is 
assigned to each Autotest. 

1. Open a job and position the cursor in the desired test field on the right side of the 
screen. Select one or several Autotest(s). 

2. Select the Edit menu. Click Set Operator or click . The Set Operator dialog 
box displays. 

 

3. Click on the drop-down Menu for a list of all operators. 

4. Select an operator from the drop-down list or enter a new operator name. 

5. Click OK when you are finished. 

FINDING A JOB OR TEST 

The Find function searches for Job Names, Cable IDs, and Tests. You can control both 
the type of match and the direction of the search. 

1. Before opening the Find dialog box: 

 Click on a folder at the Job level on the left side of the main database screen to 
find a job. 

 Click on a test in the test grid on the left side of the main database screen to 
find a test. 

2. Select the Edit menu. Click Find Job or Find Test or click  on the toolbar. The 
Find dialog box displays. 

 

3. Enter the job name and then specify the Find criteria using the Match case and 
Direction buttons. 

4. Click Find Next to search for the next occurrence of the text. 

5. Click Cancel when you are done searching. 
NOTE: If the Test/Job is not found in the UP direction, use the DOWN direction and 
repeat Steps 5 and 6. 
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WORKING AT THE TEST LEVEL 

DISPLAYING THE TEST GRID 

1. Click on a Job folder that contains tests, as indicated by a  icon. 

2. A list of test records will appear on the right side of the Database View. 
This is referred to as the Test Grid.  

 
 

VIEWING TEST DETAILS 

1. Click on a Job folder that contains tests, as indicated by an  icon. 

2. Double-click on any test entry in the test grid (left side of the main database 
screen) or hold down the Control key and type “V”. Depending on the type of 
cable, you will see individual tabs for each test. 

3. Click on the desired Test Tab to view the test results. 
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Graph Button  

The Graph button, located at the bottom of the result sheet, may or may not be 
enabled, depending on whether graph data was saved during the uploading of the test 
results. If it is enabled, you can select this button to view graphs of individual test 
results performed. 

The Graph Display  

Depending upon the test tab that has been selected, the graphical data display 
provides radio buttons on the left side to select the pair and/or test reference site of 
the graphed data.  

 

The window displays the test result data over the plot area. The small popup window 
shows the frequency and dB value of the data point at the cursor. 
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The Graph Display has its own tool bar.  

 Save 

Save a graph in one of five different file formats (Chart FX files, Chart 
FX templates (no data), Text file (data only), Metafile picture, or 
Bitmap picture). 

 Copy 

Copy a chart in one of four formats (Bitmap, Metafile, Text (data only) 
or OLE object) to the Windows clipboard. Data in the clipboard can be 
pasted into other applications.  
Bitmaps and Metafiles can be pasted into a Word document.  
Text data can be pasted into an Excel spreadsheet. 

 Color  

Change the color of various items on the graph. Click and select a color 
from the drop-down dialog. Click, hold and drag the color to the 
desired item on the chart. 

 Zoom 

Magnify an area of the graph. Click and move to the area of the plot 
that is to be magnified. Click, hold and drag on the area to be zoomed. 
This zoom operation can be repeated to intensify the magnification. 

 Vertical 

 
Toggle between showing and hiding the vertical grid lines. 

 Horizontal 

 
Toggle between showing and hiding the horizontal grid lines. 

 Data  

 
Show or hide the data values in a grid. 

 Print Preview 

 
Display the graph in a hard copy format prior to printing. 

 Print 

Open the print dialog to select a printer and set the print options. Click 
OK to print the graph. 

 

MOVING TESTS BETWEEN JOBS 

Tests may be moved between different Job folders.  

1. Click on a test (or a range of tests) to select it.  

 To select an individual test, click the first column of the preferred test. 

 To select a range of tests, click the first column then hold and drag to the last 
test preferred. 

 To select a set of non-contiguous tests, click the first column of each test while 
holding down the Control key. 
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2. Move the cursor to the bottom of the highlighted area. The cursor will show a 
rectangle. 

3. Hold the left mouse button while you drag the test(s) into a new Job folder on the 
left side of the screen. 

4. Release the mouse. 
Note: You can also use commands <Edit><Cut> and then <Edit> <Paste>. If you just 
want to copy a test, you can use the Command <Copy> instead of <Cut>. 

EDITING TESTS 

This function becomes available on the Edit menu when a test record is selected or 
when using the right mouse button.  

1. Before opening the Edit menu: 

 Click on a folder at the Job level at the left side of the main database screen to 
find a job. 

 Click on a test in the test grid on the left side of the main database screen to 
find a test. 

2. Select the Edit menu. 

3. Click Edit Test to open the Edit Test dialog box. 

4. Enter the cable ID in the text box labeled “From”. Enter the destination of the 
cable in the text box labeled “To.” 

 

5. Enter data into the From, To, and Notes text boxes. 

6. Click OK. 

SORTING THE TESTS 

The Sort function allows reorganization of tests in the Database view. The selections 
are by Result, Cable ID, Cable Origin, Cable Destination, Cable Type, Test Type, Date, 
or Time. The Sort function is available when more than one test is selected in the grid 
view by clicking on a column title. Sorting can be performed by ascending, descending 
or natural order  

1. Click on a test in the test grid on the left side of the main database screen to sort 
the tests. 

2. On the Options menu, click Sort.  

3. Click the Down Arrow next to each field and choose from the sorting options that 
are displayed.  

4. Click OK to begin the sort.  
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You can sort tests according to three different values, with highest sort criteria listed 
first, followed by the second, and then the least significant sort criteria. 

 

 

BACKING UP AND RESTORING A DATABASE 

Regular data backups to a removable storage device are recommended. You may also 
restore databases to the PC from these archives.  

The database is automatically backed up prior to every test upload. 

BACKING UP A DATABASE 

Click the File menu and select the Backup command or Click  on the toolbar. The 
backup will be placed in the current folder. 

Following a backup, the program will compact the database and remove any deleted 
records. 

Note: Prior to performing an uploading of test results the currently open database is 
automatically backed up. 

RESTORING A DATABASE 

This function uses the back.zip file and will overwrite the current database files. 

1. Click the File menu. 

2. Select the Restore Database command. The backup file will be restored to the 
current folder. 
Note: If you have received a database backup file named back.zip on a data storage 
device, proceed as follows to display the data in LANTEK REPORTER: 
 
Create a new database in LANTEK Reporter. 
Copy the backup.zip (e.g. using Explorer) into the database folder just created. 
Restore the database in LANTEK Reporter. 
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PRODUCING AND PRINTING A REPORT 

HEADERS AND FOOTERS COMMAND 

Headers and footers can be added to your printed report. In a printed report, lines will 
separate the header and footer from the body of the report if the header or footer 
contains any information. 

1. From the File menu, click Headers/Footers. The Headers/Footers dialog box 
appears. 

 

2. Select a position for your header or footer and click the accompanying Down 
Arrow. 

3. From the drop-down text box, select one of the displayed options. 

 If you select Text, the Text Box will open. Enter your information.  

 If you select Logo, you must supply the location of the Bitmap file  
(.bmp file) to be used as the logo. Type the name of the file directly into the box 
titled “Logo File:” or use the Browse function to locate the file.   

Note: Customer is a value that is set in the Edit Job function.  

4. Click OK. 
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PRINT COMMAND 

Printing involves two steps: selecting the printer; and specifying what you want to 
print. 

1. From the File menu, click Print or click  on the toolbar. The Print dialog box 
displays. 

2. Select Report Type, Printer, Print Range, and the number of Copies. 

3. Click Preview to display your report as it will appear in print. 

4. Click OK. 

 
 

The Single Line Report Layout 

The Single Line Report prints one line for each test. The tests included in the report 
are determined by what item(s) are selected in the views.  

 If a job is selected in the Tree view, all tests in that job are included.  

 If tests have been selected in the Grid view, the selected tests are reported. 

To view summary test information for the selected job, check the ‘‘Show Summary 
Data” box. 

The Brief Report Layout 

The Brief Test Report prints out summary information about all subordinate tests for 
each test. The tests included in the report are determined by what item(s) are 
selected in the views.  

 If a job is selected in the Tree view, all tests in that job are included.  

 If tests have been selected in the Grid view, the selected tests are reported. 
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To view summary test information for the selected job, check the ‘‘Show Summary 
Data” box. 

Note: In order to print the graphics presented in this report, select Save Graphs in the 
Auto Preference prior to performing tests. 

The Detailed Layout 

The Detailed Test Report prints out detailed subordinate test information for all 
selected tests. The tests included in the report are determined by what item(s) are 
selected in the views.  

 If a job is selected in the Tree view, all tests in that job are included.  

 If tests have been selected in the Grid view, the selected tests are reported.  

To view summary test information for the selected job, check the ‘‘Show Summary 
Data” box. 
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APPENDIX A 
SAFETY PRECAUTIONS 

 

HANDLE BATTERY PACKS WITH CARE 

DO NOT dispose of NiMH battery packs in a fire or with regular trash. NiMH batteries 
may explode if exposed to open flame, create hazardous waste, and contaminate 
ground water sources if disposed of in landfills. 

CAUTION - All Nickel-Metal Hydride (NiMH) battery packs, regardless of their 
indicated charge state, are capable of producing electrical currents sufficient to cause 
personal injury and/or property damage. 

IDEAL INDUSTRIES has tried to provide the maximum protection possible by installing 
an automatic reset fuse in every battery pack to help stop high current discharges as 
quickly as possible. However, this fuse may not completely protect against a 
momentary arc, which can result if the battery pack’s electrical contacts are shorted. 
The following battery pack handling precautions must be closely followed to avoid risk 
of injury. 

 When a battery pack is not installed in the handset or the charger, it should be 
kept in a clean, dry, non-conductive package. 

 Keep conductive materials away from the battery contacts at all times. 

 Keep the contact sides of the battery packs away from each other at all times. 

 Batteries are normally charged while in the handsets or when using the optional 
Dual Bay Battery Charger. Charging with other chargers or in any other manner 
may cause the battery packs to explode. 

 Always install, remove, store, and charge the battery packs in a non-explosive 
atmosphere. 

 Use and store battery packs in locations that do not exceed 122 degrees 
Fahrenheit (50 degrees Celsius). 

 Do not allow children or persons unfamiliar with the precautionary instructions in 
this manual to handle or recharge the battery packs. 

 Leave the sealed battery pack case intact. There are no user-serviceable parts 
inside the case and the batteries in the case are not replaceable. 

Note: Charge battery packs prior to use. 

STATEMENT OF LIABILITY 

IDEAL INDUSTRIES does NOT assume any liability for death, injury or damage to 
equipment or property resulting from the use of this charger in a manner inconsistent 
with the use for which it was intended. IDEAL INDUSTRIES will not be liable for 
consequences that may result from tampering with the battery packs or charger or 
consequences resulting from their use thereafter. 
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ENVIRONMENTAL STATEMENT 

If you have any questions concerning these precautions, the operating instructions, or 
any other concerns about the safe use and disposal of the LANTEK battery packs, 
please contact an IDEAL INDUSTRIES representative at one of the offices listed in 
Appendix B, Customer Service. 

IMPORTANT USER INFORMATION 

Please read this information before proceeding with any cable testing/certification 
using the LANTEK testers. 

All cable parameter default settings preprogrammed in the LANTEK testers are based 
on generic standards, proposed industry recommendations for cables and network 
links, the latest technical information available from International LAN cabling 
standards committees, the LAN industry, and IDEAL INDUSTRIES’ own experience and 
testing. However, the default settings in the tester may not yield the desired 
certification / test results in every given instance because each network is a custom 
installation designed to suit the requirements of the users. It is therefore imperative 
that specific network parameter limits be obtained from the network designer(s) and 
employed during certification and testing. 
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CUSTOMER SERVICE 

TECHNICAL ASSISTANCE  

For technical assistance or service questions in the U.S.A. and Canada, call IDEAL 
INDUSTRIES at 1-800-854-2708 or 858-627-0100. 

SERVICE IN THE USA 

Your LANTEK tester may require annual calibration to meet accuracy specifications. 
Before returning a unit for calibration or service, call IDEAL INDUSTRIES Technical 
Support at 1-800-854-2708 or 858-627-0100. 

Note: If cleaning is required, use a soft cloth and mild cleaner suitable for plastic. Do 
not immerse the tester in water. 

When returning a unit for service or calibration: 

1. Customer name, company, address, telephone number, proof of purchase (for 
warranty repairs), and a description of the service are required. 

2. Pack in a soft carrying case, hard-sided carrying case, or wrap the instrument in 
heavy paper or plastic. 

3. Use a strong shipping container. A double-walled carton of 250-pound test material 
is recommended. 

4. Use a layer of shock-absorbing material 70 to 100 mm (3 to 4 inches) thick around 
all sides of the instrument to provide firm cushioning and to prevent the unit from 
moving inside the container. 

5. Seal the shipping container securely. 
 
Ship prepaid to:  
IDEAL INDUSTRIES Corporation 
9650 Chesapeake Drive 
San Diego, CA  92123 
ATTN: Instrument Repair/Service 
 

Return shipping to the customer within the domestic U.S.A. will be paid by IDEAL 
INDUSTRIES Corporation.  

SERVICE OUTSIDE THE USA 

For technical assistance or service questions outside the U.S.A. and Canada, call your 
local distributor. 

IDEAL INDUSTRIES recommends annual calibration of the LANTEK testers to ensure 
that it continually meets its accuracy specifications. Before returning a unit for 
calibration or service outside the U.S.A., contact your local distributor or one of the 
IDEAL INDUSTRIES Corporation offices listed below. If your local distributor does not 
have a service facility, they will provide assistance in returning the tester to an 
authorized IDEAL INDUSTRIES service facility. 
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Americas 

IDEAL INDUSTRIES Corporation 
9650 Chesapeake Drive 
San Diego, CA 92123 
Tel: 800-854-2708 
Fax: 858-715-7003 

Europe (Germany, France, Italy, Spain, Portugal, Switzerland, Austria, 
Eastern Europe, MEA) 

IDEAL INDUSTRIES GmbH 
Gutenbergstrasse 10 
85737 Ismaning, Germany 
Tel: +49-89-99686-0 
Fax: +49-89-99686-111 

United Kingdom (Netherlands, Belgium, Luxembourg, Sweden, Norway, 
Finland, Denmark, Iceland) 

IDEAL INDUSTRIES (UK) Ltd. 
225 Europa Boulevard, Gemini Business Park 
Warrington, Cheshire WA5 7TN, England 
TEL: +44-1925-444446 
FAX: +44-1925-445501 

IDEAL Industries China, L.L.C. 

Unit 911, Tower W1, Oriental Plaza 
No. 1 East Chang An Avenue, Dongcheng District 
Beijing, 100738, China 
Tel: +86-10-8518-3141 
Fax: +86-10-8518-3143 

IDEAL Industries Brazil Comercio LTDA 

Av. Major Sylvio de M. Padilha, 5200, Bloco F, Cj 201 
CEP – 05677-000 
Sao Paulo – SP – Brazil 
05677-000 – Brazil 
Tel: +55-11-3759-8777 
Fax: +55-11-3759-8775 

IDEAL Industries Mexico 

Parque Intermex 
Periferico Sur 7999 A 
Col. Sta. Ma. Tequepexpan 
Tlaquepaque, Jalisco 45601 
Mexico 
Tel: +52-33-37702320 
Fax: +52-33-37702300 
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IDEAL Industries (Australia) PTY.Limited 

Level 6 
75-85 Elizabeth Street 
Sydney NSW 2000 Australia 
Tel: 61300-765-800 (Australia) 
Tel: 61405-123-100 (New Zealand) 
Fax: 61300-765-801 

 

WEB SERVICES 

IDEAL INDUSTRIES provides a Web (www) site for LAN cable test products that allows 
you to use a PC and modem to obtain the latest information on cable test application 
notes or firmware version upgrades. A question and answer forum allows you to share 
information with other users and submit questions to IDEAL INDUSTRIES product 
managers. 

You can download the latest firmware updates for your LANTEK tester and the 
corresponding version of the LANTEK Reporter analysis software using a PC with an 
Internet service connection. Upgrade files are available on the World Wide Web at: 

http://www.idealindustries.com 
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APPENDIX C 
FIBER OPTIC CABLING 

STANDARDS & APPLICATION 
REQUIREMENTS 

 

Summary of Fiber Optic Cabling Standards & Application Requirements 
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TIA 568-B.3 Horizontal link Multimode 62.5/850 n/s 0.75 0.3 >20 90 n/s 3.5 160
Horizontal link Multimode 50/850 n/s 0.75 0.3 >20 90 n/s 3.5 500
Horizontal link Multimode 62.5/1300 n/s 0.75 0.3 >20 90 n/s 1.5 500
Horizontal link Multimode 50/1300 n/s 0.75 0.3 >20 90 n/s 1.5 500
Backbone Multimode 62.5/850 n/s 0.75 0.3 >20 2km n/s 3.5 160
Backbone Multimode 50/850 n/s 0.75 0.3 >20 2km n/s 3.5 500
Backbone Multimode 62.5/1300 n/s 0.75 0.3 >20 2km n/s 1.5 500
Backbone Multimode 50/1300 n/s 0.75 0.3 >20 2km n/s 1.5 500

Horizontal link Single mode 9/1310 n/s 0.75 0.3 >26 90 n/s 1.0 n/a

Horizontal link Single mode 9/1550 n/s 0.75 0.3 >26 90 n/s 1.0 n/a

Backbone (ISP) Single mode 9/1310 n/s 0.75 0.3 >26 3km n/s 1.0 n/a

Backbone (ISP) Single mode 9/1550 n/s 0.75 0.3 >26 3km n/s 1.0 n/a
Backbone - 
(OSP) Single mode 9/1310 n/s 0.75 0.3 >26 3km n/s 0.5 n/a
Backbone - 
(OSP) Single mode 9/1550 n/s 0.75 0.3 >26 3km n/s 0.5 n/a

OF-300 OM1
50 or 
62.5/1300 1.95

0.75 ea/ 
1.5 total 0.3 >20 n/s 300 1.5 500

OF-300 OM2
50 or 
62.5/850 2.55

0.75 ea/ 
1.5 total 0.3 >20 n/s 300 3.5 500

OF-300 OM2
50 or 
62.5/1300 1.95

0.75 ea/ 
1.5 total 0.3 >20 n/s 300 1.5 500

ISO 11801 
Generic 
Cabling

Generic 
Cabling
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OF-300 OM3 50/850 2.55
0.75 ea/ 
1.5 total 0.3 >20 n/s 300 3.5 1500

OF-300 OM3 50/1300 1.95
0.75 ea/ 
1.5 total 0.3 >20 n/s 300 1.5 500

OF-300 OS1
9/1310 or 
1550 1.80

0.75 ea/ 
1.5 total 0.3 >35 n/s 300 1.0 n/s

OF-500 OM1
50 or 
62.5/850 3.25

0.75 ea/ 
1.5 total 0.3 >20 n/s 500 3.5 200

OF-500 OM1
50 or 
62.5/1300 2.25

0.75 ea/ 
1.5 total 0.3 >20 n/s 500 1.5 500

OF-500 OM2
50 or 
62.5/850 3.25

0.75 ea/ 
1.5 total 0.3 >20 n/s 500 3.5 500

OF-500 OM2
50 or 
62.5/1300 2.25

0.75 ea/ 
1.5 total 0.3 >20 n/s 500 3.5 500

OF-500 OM3 50/850 3.25
0.75 ea/ 
1.5 total 0.3 >20 n/s 500 3.5 1500

OF-500 OM3 50/1300 2.25
0.75 ea/ 
1.5 total 0.3 >20 n/s 500 1.5 500

OF-500 OS1
9/1310 or 
1550 2.00

0.75 ea/ 
1.5 total 0.3 >35 n/s 500 1.0 n/a

OF-2000 OM1
50 or 
62.5/850 8.50

0.75 ea/ 
1.5 total 0.3 >20 n/s 2km 3.5 200

OF-2000 OM1
50 or 
62.5/1300 4.50

0.75 ea/ 
1.5 total 0.3 >20 n/s 2km 1.5 500

OF-2000 OM2
50 or 
62.5/850 8.50

0.75 ea/ 
1.5 total 0.3 >20 n/s 2km 3.5 500

OF-2000 OM2
50 or 
62.5/1300 4.50

0.75 ea/ 
1.5 total 0.3 >20 n/s 2km 1.5 500

OF-2000 OM3 50/850 8.50
0.75 ea/ 
1.5 total 0.3 >20 n/s 2km 3.5 1500

OF-2000 OM3 50/1300 4.50
0.75 ea/ 
1.5 total 0.3 >20 n/s 2km 1.5 500

OF-2000 OS1
9/1310 or 
1550 3.50

0.75 ea/ 
1.5 total 0.3 >35 n/s 2km 1.0 n/a

IEEE 802.3 10Base-FL
Multimode/ 
OM1-OM2 62.5/850 12.50

0.75 ea/ 
1.5 total n/s >20 2km 0 3.75 160

10Base-FL
Multimode/ 
OM1-OM3 50/850 12.50

0.75 ea/ 
1.5 total n/s >20 1.5km 0 3.75 160

100Base-FX
Multimode/ 
OM1-OM3

62.5 or 
50/1300 11.00

0.75 ea/ 
1.5 total n/s n/s 2km 0 3.75 500

1000Base-SX
Multimode/ 
OM1-OM2 62.5/850 2.33

0.75 ea/ 
1.5 total n/s >20 n/s 220 3.75 160

1000Base-SX
Multimode/ 
OM2-OM3 62.5/850 2.53

0.75 ea/ 
1.5 total n/s >20 n/s 275 3.75 200

1000Base-SX
Multimode/ 
OM1-OM3 50/850 3.25

0.75 ea/ 
1.5 total n/s >20 n/s 500 3.5 400

1000Base-SX
Multimode/ 
OM2-OM3 50/850 3.43

0.75 ea/ 
1.5 total n/s >20 n/s 550 3.5 500

1000Base-LX
Multimode/ 
OM1-OM2 62.5/1300 2.32

0.75 ea/ 
1.5 total n/s >20 n/s 550 1.5 500

1000Base-LX
Multimode/ 
OM1-OM2 50/1300 2.32

0.75 ea/ 
1.5 total n/s >20 n/s 550 1.5 400/500

1000Base-LX
Singlemode/ 
OS1 9/1310 4.50

0.75 ea/ 
1.5 total n/s >26 n/s 5km 0.5 n/a

10GBase-SR
Multimode-
OM1 62.5/850 2.60

0.75 ea/ 
1.5 total n/s >20 n/s 26 3.5 160

10GBase-SR
Multimode-
OM1 62.5/805 2.50

0.75 ea/ 
1.5 total n/s >20 n/s 33 3.5 200

10GBase-SR
Multimode/ 
OM2-OM3 50/850 2.20

0.75 ea/ 
1.5 total n/s >20 n/s 66 3.5 400

ISO 11801 
Generic 
Cabling

ISO 11801 
Generic 
Cabling
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IEEE 802.3 10GBase-SR
Multimode/ 
OM2-OM3 50/850 2.30

0.75 ea/ 
1.5 total n/s >20 n/s 82 3.5 500

10GBase-SR
Multimode/O
M3 50/850 2.60

0.75 ea/ 
1.5 total n/s >20 n/s 300 3.5 2000

10GBase-LR
Singlemode/ 
OS1 9/1310 6.00

0.75 ea/ 
1.5 total n/s >26 n/s 10km 0.5 n/a

10GBase-EW
Singlemode/ 
OS1 9/1550 5>11

0.75 ea/ 
1.5 total n/s >26 n/s 30-40km n/s n/a

ISO/IEC 
14165

133MbB/s Fibre 
Channel

Multimode/ 
OM1-OM3 62.5/1300 6.00

0.75 ea/ 
1.5 total n/s n/s n/s 1500 n/s 500

266Mb/s Fibre 
Channel

Multimode/ 
OM1-OM3

50 or 
62.5/850 12.00

0.75 ea/ 
1.5 total n/s n/s n/s 2000/700 n/s 500

266Mb/s Fibre 
Channel

Multimode/ 
OM1-OM3 62.5/1300 6.00

0.75 ea/ 
1.5 total n/s n/s n/s 330 n/s 500

266Mb/s Fibre 
Channel

Multimode/ 
OM1-OM3 50/1300 5.50

0.75 ea/ 
1.5 total n/s n/s n/s 500 n/s 500

266Mb/s Fibre 
Channel

Singlemode/ 
OS1 9/1310 6.00

0.75 ea/ 
1.5 total n/s n/s n/s 2000 n/s n/a

531Mb/s Fibre 
Channel

Multimode/ 
OM1-OM3

50 or 
62.5/850 8.00

0.75 ea/ 
1.5 total n/s n/s n/s 1000/350 n/s 500/160

531Mb/s Fibre 
Channel

Singlemode/ 
OS1 9/1310 14.00

0.75 ea/ 
1.5 total n/s n/s n/s 2000 n/s n/a

1062Mb/s Fibre 
Channel

Multimode/ 
OM1-OM3

50 or 
62.5/850 4.00

0.75 ea/ 
1.5 total n/s n/s n/s 1000/350 1.5/3.5 500/200

1062Mb/s Fibre 
Channel

Singlemode/ 
OS1 9/1310 6.00

0.75 ea/ 
1.5 total n/s n/s n/s 2000 0.5 n/a

Definitions

Max fiber attenuation - Indicates max allowable loss per km. Verify from mfg that your cable is less than spec'd limit
Connector return loss - Indicate reflected power from connectors. Failures indicate polishing or cleaning problems.

Minimum operating distance - Most standards do not limit the length, instead require operation to a minimum lentgh
Link channel loss - The maximum allowable loss measured with a power meter/light source kit
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